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WARRANTY 

 

LKC Technologies, Inc. unconditionally warrants this instrument to be free from defects in materials 

and workmanship, provided there is no evidence of abuse or attempted repairs without authorization 

from LKC Technologies, Inc.  This Warranty is binding for one year from date of installation and is 

limited to:  servicing and/or replacing any instrument, or part thereof, returned to the factory for that 

purpose with transportation charges prepaid and which are found to be defective.  This Warranty is 

made expressly in lieu of all other liabilities and obligations on the part of LKC Technologies, Inc. 

 

DAMAGE UPON ARRIVAL.  Each instrument leaves our plant, after rigorous tests, in perfect 

operating condition.  The instrument may receive rough handling and damage in transit.  The shipment 

is insured against such damage.  The Buyer must immediately report, in writing, any concealed or 

apparent damage to the last carrier as well as to us and issue an order for replacement or repair. 

 

DEFECTS OCCURRING WITHIN WARRANTY PERIOD.  Parts of the units may develop defects 

which no amount of initial testing would have revealed.  The price of our instruments makes provision 

for such service, but it does not: 

 

  1. Provide for transportation charges to our factory for service, 

  2. Provide for services not performed or authorized by us, 

  3. Provide for the cost of repairing instruments that have obviously been abused or subjected to 

unusual environments for which they have not been designed. 

 

We will be happy at any time to discuss by phone, letter, FAX, or e-mail suspected defects or 

aspects of instrument operation that may be unclear.  We advise you to inform us by phone, letter, FAX, 

or e-mail of the nature of the defect before returning an instrument for repair.  Many times a simple 

suggestion will solve the problem without returning an instrument to the factory.  If we are unable to 

suggest something that solves the problem, we will advise you as to what parts of the equipment should 

be returned to the factory for service. 

 

 

mailto:Support@LKC.com
http://www.lkc.com/
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DEFECTS OCCURRING AFTER WARRANTY PERIOD.  Charges for repairs after the warranty 

period and within LKC product lifetime policy will be based upon actual hours spent on the repair at the 

prevailing rate, plus cost of parts required and transportation charges; or you may elect to purchase an 

extended warranty. 

 

We will be happy to discuss by phone, letter, FAX, or e-mail any problem you may be experiencing. 

 

LKC PRODUCT LIFETIME POLICY.  The lifetime of a UTAS system is 7 years from the original 

shipment date of the UTAS system.  LKC will service any UTAS system that is within its lifetime. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SOFTWARE LICENSE 

 

The UTAS software is a copyrighted product of LKC Technologies, Inc. and is included with the UTAS 

system under the following license agreement: 

 

The software may be used in conjunction with the UTAS system only.  The purchaser of the 

UTAS system may make copies of the software for convenience of use, provided the LKC 

copyright notice is preserved with each copy.  This license specifically prohibits the use of this 

software in a system that does not include an LKC Technologies, Inc. UTAS Interface Unit.  

Additional copies of the software may be purchased to produce reports of UTAS data using a 

stand-alone computer system. 

 

 

 

 
LKC Technologies, Inc. 

 
Customer Service/Support 

800.638.7055 (US & Canada) 
301.840.1992 (Worldwide) 

 
301.330.2237 (FAX) 

 
Support@LKC.com 

 
www.LKC.com 
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INTRODUCTION 

 

LKC’s UTAS visual electrodiagnostic test system is designed for electroretinogram 

(ERG), visual evoked response (VER) (also called visual evoked potentials (VEP)), and 

electro-oculogram (EOG) testing. It can be upgraded with additional software allowing 

for multifocal ERG and multifocal VEP. The additional testing software are covered in 

different manuals. The UTAS is a fully automated system providing features needed for 

both clinical and research applications. The UTAS meets all the specifications and 

requirements of the International Society for the Clinical Electrophysiology of Vision 

(ISCEV).  

 

This manual is divided into three components: the Hardware Manual, the Software 

Manual, and the Testing Manual. The Hardware Manual covers the setup and 

calibration of the equipment. The Software Manual covers all aspects of the software. 

Explicit instruction on testing patients is covered in the Testing Manual. It is important to 

be familiar with the Hardware Manual and the Software Manual before you go through 

the Testing Manual. 

 

This equipment is offered for sale only to qualified Health Professionals. The improper 

use of this equipment may cause injury to the patient.  
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1.0 Introduction 

 

1.1 Overview 

 

This UTAS system Manual is divided into three sections; the Hardware, Software, and Testing 

manuals. The Hardware Manual will explain how the system is connected, the specifications for 

the system, how to use the hardware features, and how to assist LKC in servicing the system 

should trouble arise. Subsequent sections, the Software Manual and the Testing manual, will 

explain how to use the software and the details of performing a patient test.  

 

1.2 Safety  

 

The equipment has been tested in accordance with IEC EN60601-1-2:2001 and meets all 

requirements for type B Patient Connections. 

 

1.3 Use 

 

The LKC UTAS Visual Electrodiagnostic Testing System is an ophthalmic evoked potential 

system. Its function is to elicit electrical responses from the retina and visual pathways for 

diagnostic purposes.  

 

The UTAS is designed for the electroretinogram (ERG), electro-oculogram (EOG), visual 

evoked potential (VEP), and multi-focal ERG tests. These tests are useful aids in the diagnosis of 

a wide range of visual disorders. 

 

The system also has the capability to run multi-focal electroretinogram (mfERG) and multi-focal 

visual evoked potentials (mfVEP) tests. A UV stimulus add-on is also possible on a BigShot 

ganzfeld.  These tests can be purchased as options to the system (contact LKC for availability), 

and are discussed in detail in a separate user’s manuals.   

 

This equipment is offered for sale only to qualified Health Professionals.  The improper use of 

this equipment may be cause injury to the patient and/or damage to the equipment. 

 

1.4 Essential Performance 

 

 Correct operation of system components, including visual stimuli, i.e. flash, flicker, fixation, 

background light and pattern stimulus; data acquisition; data analysis and test result display. 

 Accuracy of intensity and timing of various visual stimuli. 

 Accuracy of patient amplifier gain, and data acquisition timing. 

 Accuracy of data analysis and result display. 

 

 

 

 

 

1.5 Precautions 
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 All servicing of this equipment is to be performed by LKC Technologies, Inc. or by a service 

center approved by LKC Technologies, Inc. 

 

 Only equipment supplied by LKC Technologies, Inc. should be plugged into the 115 V 

outlets at the back of the MGIT-100 component. 

 

 The UTAS system needs special precautions regarding EMC and needs to be installed and 

put into service according to the EMC information provided in this User’s Manual. 

 

 Portable and mobile RF communications equipment can affect UTAS performance.  

 

 Input overload can occur with defibrillator or electrocautery if used in the operating room.  

 

 Any device connected to this system must be explicitly approved by LKC Technologies, Inc. 

and must meet the relevant requirements of IEC60601-1. 

 

 The use of any accessories or replacement of components other than those supplied by or 

approved by LKC Technologies, Inc. may compromise patient safety. 

 

 Eye infections may result from use of non-sterilized contact-lens electrodes. 

 

 The forehead rest should be cleaned and disinfected after each patient. 

 

 This device is not protected against the ingress of water and should not be used in the 

presence of liquids which may enter the device. 

 

 This device is not suitable for use in the presence of a flammable anesthetic mixture of air, or 

with oxygen or nitrous oxide. 

 

 Replacement AC fuses shall only be - T2.5A 250 V (Slow-Blow) for 210-230 volt power-

line countries, and T5.0A 250 V (Slow-Blow) for 100 – 120 volt power-line countries. 

 

 This is an EU/MDD class I device requiring a three pronged grounded outlet. 

 

 WARNING: To avoid the risk of electric shock, this equipment must only be connected to a 

supply mains with protective earth. 

 

 WARNING: Do not modify this equipment without authorization of the manufacturer. 

 

 Connect the MGIT-100 directly to a wall outlet.  Do not connect the MGIT-100 to a wall 

outlet through an extension cord or a multiple socket-outlet 

 

 The UTAS system is an FDA Class II medical device that incorporates a personal computer.  

To ensure patient safety, the personal computer and all of its peripherals are powered from an 

isolation transformer, through the power receptacles on the back of the MGIT-100.  All 
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devices connected to the computer must be powered from these isolated power receptacles.  

Failure to observe these precautions may endanger the patient and will void the product 

warranty.  LKC Technologies, Inc. will not service a system whose computer is connected to 

external devices, nor will it give permission for others to service such a system. 

 

Examples of improper connections include connecting the UTAS computer 

(whether supplied by LKC or by another party) to a laser printer, or to any other 

device that is plugged into a wall outlet or that is connected to another device 

that is plugged into a wall outlet (such as a printer sharing unit connected to 

another computer).  If you have specific questions on this matter, please contact 

LKC Technologies, Inc. for advice. 

 

 Ensure the amplifier unit battery is fully charged prior to use. 

 

 A fully charged battery will provide 12+ hours of useable recording time.  

 

 Do not record while amplifier is recharging!  This will compromise the quality of recordings 

and subject isolation. 

 

 

 

1.6 Special Precautions Concerning EMC 

 

 

 

 

Guidance and manufacturer’s declaration – electromagnetic emissions 

The UTAS is intended for use in the electromagnetic environment specified below. The customer 
or the user of the UTAS should assure that it is used in such an environment. 

Emissions test Compliance Electromagnetic environment – guidance 

RF emissions 
CISPR 11 

Group 1 

The UTAS uses RF energy only for its internal 
function. Therefore, its RF emissions are very 
low and are not likely to cause any interference 
in nearby electronic equipment. 

RF emissions 
CISPR 11 

Class A 

The UTAS is suitable for use in all 
establishments other than domestic and those 
directly connected to the public low-voltage 
power supply network that supplies buildings 
used for domestic purposes. Harmonic emissions 

IEC 61000-3-2 
Class A 

Voltage fluctuations/ 
flicker emissions 
IEC 61000-3-3 

Complies 
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Warning: The UTAS system should not be used adjacent to or stacked with other equipment 

and if adjacent or stacked use is necessary, the UTAS should be observed to verify normal 

operation in the configuration in which it will be used. 

 

Guidance and manufacturer’s declaration – electromagnetic immunity 

The UTAS is intended for use in the electromagnetic environment specified below. The customer 
or the user of the UTAS should assure that it is used in such an environment. 

Immunity test 
IEC 60601 
test level 

Compliance level 
Electromagnetic 
environment – 

guidance 

Electrostatic 
discharge (ESD) 
IEC 61000-4-2 

±6 kV contact 
 
±8 kV air 

±6 kV contact 
 
±8 kV air 

Floors should be wood, 
concrete or ceramic tile. If 
floors are covered with 
synthetic material, the 
relative humidity should be at 
least 30 %. 
 

Electrical fast 
transient/burst 
IEC 61000-4-4 

±2 kV for power 
supply lines 
 
±1 kV for input/output 
lines 

±2 kV for power 
supply lines 
 
±1 kV for input/output 
lines 

Mains power quality should 
be that of a typical 
commercial or hospital 
environment. 
 

Surge 
IEC 61000-4-5 

±1 kV line(s) to line(s) 
 
±2 kV line(s) to earth 

±1 kV line(s) to line(s) 
 
±2 kV line(s) to earth 

Mains power quality should 
be that of a typical 
commercial or hospital 
environment. 

Voltage dips, 
short 
interruptions and 
voltage 
variations 
on power supply 
input lines 
IEC 61000-4-11 

<5 % UT 
(>95 % dip in UT) 
for 0,5 cycle 
 
40 % UT 
(60 % dip in UT) 
for 5 cycles 
 
70 % UT 
(30 % dip in UT) 
for 25 cycles 
 
<5 % UT 
(>95 % dip in UT) 
for 5 sec 

<5 % UT 
(>95 % dip in UT) 
for 0,5 cycle 
 
40 % UT 
(60 % dip in UT) 
for 5 cycles 
 
70 % UT 
(30 % dip in UT) 
for 25 cycles 
 
<5 % UT 
(>95 % dip in UT) 
for 5 sec 

Mains power quality should 
be that of a typical 
commercial or hospital 
environment. If the user of 
the UTAS requires continued 
operation during power 
mains interruptions, it is 
recommended that the UTAS 
be powered from an 
uninterruptible power supply 
or a battery. 
 

Power frequency 
(50/60 Hz) 
magnetic field 
IEC 61000-4-8 

3 A/m 3 A/m 

Power frequency magnetic 
fields should be at levels 
characteristic of a typical 
location in a typical 
commercial or hospital 
environment. 
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NOTE UT is the a.c. mains voltage prior to application of the test level. 

 
 
 
 
 
 
 

Guidance and manufacturer’s declaration – electromagnetic immunity 

The UTAS is intended for use in the electromagnetic environment specified below. The customer 
or the user of the UTAS should assure that it is used in such an environment. 

Immunity 
test 

IEC 60601 
test level 

Compliance 
level 

Electromagnetic environment – 
guidance 

 
 
 
 
 
 
 
 
 
Conducted 
RF IEC 
61000-4-6 
 
Radiated RF 
IEC 61000-
4-3 

 
 
 
 
 
 
 
 
 
3 Vrms 
150 kHz to 80 
MHz 
 
3 V/m 
80 MHz to 2,5 
GHz 

 
 
 
 
 
 
 
 
 
3 Vrms 
 
 
 
3 V/m 

Portable and mobile RF communications 
equipment should be used no closer to any part 
of the UTAS, including cables, than the 
recommended separation distance calculated 
from the equation applicable to the frequency of 
the transmitter. 
 
Recommended separation distance 
 

Pd 2.1  

 

 

Pd 2.1          80 MHz to 800 MHz 

 

Pd 3.2         800 MHz to 2,5 GHz 

 
where P is the maximum output power rating of 
the transmitter in watts (W) according to the 
transmitter manufacturer and d is the 
recommended separation distance in meters (m). 
 
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site survey, 
should be less than the compliance level in each 
frequency range. 
 
Interference may occur in the vicinity of 
equipment marked with the following symbol: 
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NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 
 
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected 
by absorption and reflection from structures, objects and people.  

a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless), 
telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast 
cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due 
to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured 
field strength in the location in which the UTAS is used exceeds the applicable RF compliance 
level above, the UTAS should be observed to verify normal operation. If abnormal performance is 
observed, additional measures may be necessary, such as reorienting or relocating the UTAS. 
 
b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.  

 

 

Recommended separation distances between 
portable and mobile RF communications equipment and the UTAS 

The UTAS is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of the UTAS can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile 
RF communications equipment (transmitters) and the UTAS as recommended below, according 
to the maximum output power of the communications equipment.  

Rated maximum 
output power 
of transmitter 

W 

Separation distance according to frequency of transmitter 
M 

150 kHz to 80 MHz 

Pd 2.1  

80 MHz to 800 MHz 

Pd 2.1  

800 MHz to 2,5 GHz 

Pd 3.2  

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the recommended separation 
distance d in meters (m) can be estimated using the equation applicable to the frequency of the 
transmitter, where P is the maximum output power rating of the transmitter in watts (W) according 
to the transmitter manufacturer. 
 
NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
 
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected 
by absorption and reflection from structures, objects and people.  
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1.7 Warning 

 

The Ganzfeld is capable of producing intense light, which patient exposure may 

exceed ICNIRP guidelines. Users should consider the effects of producing stimuli at 

these intensities. 

 

If the BigShot Ganzfeld contains the optional UV stimulator, the Ganzfeld contains 

an LED source which provides UV emissions in excess of the Exempt Risk Group 

as defined in IEC 62471.  The Ganzfeld risk categorization is Risk Group 2 

(moderate risk).  The ultraviolet radiation is centered at 365 nm.  The light hazard 

occurs only if the UV stimulator is used as a bright background light.  Brief flashes 

of UV light from this instrument are not hazardous.  If the BigShot will be used to 

produce UV background light, we recommend that UV-blocking eye protection is 

worn while looking into the Ganzfeld. 

 

1.8 Symbols 

 
 

 Caution! Read instructions before using. 

 

UV

 Contains UV stimulator 

 

     Power Off 

 

 Self-Test 

 

        Power On 

 

 Battery Check 

 

  

 DC Power 

 

 

UV



UTAS Hardware 

 
 

Version 2.4 8 

   IEC 60601-1 Class I Type BF 

 

   IEC 60601-1 Class I Type B 

 

 

     Fuse Rating:  “T2.5A 250V” is for 210-230 VAC power-line countries   

              “T5.0A 250V” is for 100-120 VAC power-line countries 

 

 

 Volts AC 

 

Council Directive Compliance 

 

 

Earth ground connection point, functional earth terminal 

   

 Chassis ground, protective earth terminal 

 

 

1.9 Approvals 

 

This product has been tested for EMI and complies with the requirements of EN 60601-1-1-

2:2001 (Group 1 Class A device under CISPR 11). Use of this equipment in the vicinity of other 

equipment with excessive EMI may interfere with the proper operation of this product.  

 

This product conforms to IEC601-1:1988 with Amendments A1:1991 and A2:1995, and to 

EN60601-1:1990. 

 

This product has been tested in accordance with AAMI Safe Current Limits Standard and meets 

all requirements for direct patient connection. The product is an AC line powered device 

designed to meet the applicable requirements of UL 60601-1 Standard for Safety (Medical and 

Dental Equipment). This device should only be used according to the manufacturer’s instructions 

and by qualified health professionals. 

 

This product has been approved for both CE and CB certificates 

0086 

T2.5A 250V 
Or 
T5.0A 250V 
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European Representative 

 

Emergo Europe    Symbol 
 

Molenstraat 15 

2513 BH The Hague 

The Netherlands 

 

Tel:   +31 70-345-8570 

Fax:  +31 70-346-7299  

 
 

 



UTAS Hardware 

 
 

Version 2.4 10 

2.0 Functional Description 

 

In this section, the function of each equipment group is explained and a block diagram showing 

equipment interrelationships is discussed. The UTAS system can come with either a SunBurst 

Ganzfeld (designed for humans and larger animals) or the BigShot Ganzfeld (fits most small 

animals and primate faces). The BigShot Ganzfeld can be upgraded with a UV stimulator.  

 

2.1 UTAS System Quick Specs 

SUNBURST GANZFELD STIMULATOR 

Size and Weight  13.5” W x 10.5” D x 8” H, 5.0 lbs  

Flash Intensity   Maximum Luminance of ~2500 cd-s/m
2
 (+30 dB) for Xenon Flash 

Typical Maximum Luminance of ~160 cd-s/m
2
 (+18 dB) for white 

LED Flash, 18 dB for green LED Flash, 16 dB for red LED Flash, 

and 11 dB for blue LED Flash 

   Dynamic Range of 105dB (+30 dB to -75 dB) in 0.01dB steps 

Flash Intensity Tolerance  1 dB 

Background Intensity 0.005 to 5000 cd/m
2
 in any color (4000 in blue) in 0.01 dB steps.   

0.001 to 5000 cd/m
2
 in white in 0.01 dB steps. 

Background Intensity 10% 

Tolerance 

LED wavelength  Red (627 nm), Green (530nm), Blue (470 nm) and Amber (590 nm) 

BIGSHOT GANZFELD STIMULATOR 

Size and Weight  15.5” W x 12.5” D x 19.5” H, 17.0 lbs  

    14” Diameter Full Field Globe 

Flash Intensity   Maximum Luminance of ~800 cd-s/m
2
 (+25 dB) for Xenon Flash 

Typical Maximum Luminance of ~25 cd-s/m
2
 (+12 dB) for white 

LED Flash, 10 dB for green LED Flash, 8 dB for red LED Flash, 

and 4 dB for blue LED Flash 

   Dynamic Range of 100 dB (+25dB to -75dB) in 0.01 dB steps 

Flash Intensity Tolerance  1 dB 

Background Intensity 0.005 to 1000 cd/m
2
 in any color in 0.01 dB steps 

   0.001 to 1000 cd/m
2
 in white in 0.01 dB steps 

Background Intensity 10% 

Tolerance 

LED wavelength  Red (627 nm), Green (530nm), Blue (470 nm) and Amber (590 nm) 

Optional UV LED Wavelength 365 nm, typical Maximum Flash or 0 dB, typical 

Maximum background of 500 cd/m
2
  

     

PATTERN STIMULATOR 

Checkerboard Sizes  1 x 1 to 128 x 128 (in powers of 2) 

Alternation Rate  0.25 Hz to 32.5 Hz  

Screen Luminance  100 cd/m
2   
10% 

AMPLIFIER UNIT  
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Input Type   Analog Differential 

Input Channels   4 (user selectable) 

Input Impedance  10 M 

Connector Type  1.5 mm Male DIN Safety electrode connections  

Background Noise  < 0.7 V p-p @   100 Hz Sampling Rate, 10 KΩ Input 

   < 1.8 V p-p @ 1000 Hz Sampling Rate, 10 KΩ Input 

CMRR   > 110 dB at 50 – 60 Hz 

Frequency Range  AC Coupled with a frequency range of 0.1 Hz to 15 kHz 

Input Gain   1, 2, 4, 8, 16, 32, 64 (user selectable) 

DC Input Range  2 V (Gain = 1) 

Stability   < 250 nV / C drift 

Accuracy   < 0.2% absolute, Nonlinearity < 0.0010% 

Calibration    Automatic gain and offset calibration on demand 

Data Resolution  0.25 V / bit (Gain = 1) to 3.7 nV / bit (Gain = 64)  

Sampling Rate   5 Hz to 3750 Hz  

Data Connection Bidirectional fiber optic cable (TOSlink) to UBA-4204 interface  

Safety < 1 nA Leakage Current; > 10 kV Isolation when operated 

according to instructions 

Power Source   Rechargeable Li-Ion Battery  

Battery Charger  100-240 V 50/60 Hz, 12 V 1.0 A (included) 

Operating Time  Up to 12 hours of continuous use before recharging 

Recharge Time   4 hours to 80% capacity, 8 hours to 100% 

Environmental   0 C to 55 C (32 F to 131 F) 

Size   5¾” x 3¼” x 1” (14.6 cm x 8.3 cm x 2.5 cm) 

Weight   8 oz. (225 g), including battery  

SYSTEM INTERFACE UNIT 

Computer Interface  USB 2.0 + RS-232 

Power Source   100-240 VAC 100W 

Size    10” x 10” x 4” 

Weight             6.5 lb 

 

UBA-4204 INTERFACE 

Computer Interface  USB 1.1 

Power Source   USB Powered 

Size     6” x 3” x 2¼“(15 cm x 7.6 cm x 5.7 cm) 

Weight   8 oz (225 g) 

 

POWER REQUIREMENTS 

Input Voltage  100/115/230 VAC 10% 

Input Frequency     47 to 63 Hz 

Power Consumption    520 watts maximum 

 

OPERATING ENVIRONMENT 
Operating Temperature 5 °C to 35 °C 
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Humidity  15% to 80% RH non-condensing 

Storage Temperature -40 °C to 70 °C 

 

2.2 Computer and Associated Devices 

The computer is either a desktop or notebook PC with a minimum of 1 GHz CPU speed 448 MB 

of Random Access Memory (RAM), at least 80 GB hard disk drive, and a rewritable CD drive. 

The computer provides the control of all test and analysis operations.  

 

An additional video card is added to the computer by LKC. This video board sends video signal 

to the operator’s LCD monitor.  

 

2.3 System Interface 

 

The system interface contains: 

 24 V Medical Grade Power Supply 

 Interface printed circuit board 

 A toroidal high voltage transformer 

 

2.4 UBA-4204 Patient Amplifier and Interface 

 

UBA-4204 is the patient amplifier board. The electrodes used on the patient plug in the head end 

of the amplifier. The amplifier converts data from an analog to digital signal and transfers the 

data to its interface via a fiber optic cable (TOSlink). The data is then converted in the UBA-

4204 to go onto the computer via a USB 1.1 connection.  
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2.4.1 UBA-4204 controls  

 
Powering On/Off 

 

 Press the “On” button for at least ½ second to turn the Amplifier on.  The Power Light / 

Battery Status Indicator will illuminate and the test indicator light will illuminate for 

2 seconds.  Within approximately one second, it may change color to indicate the 

remaining battery capacity. 

 

 If the amplifier is not in use for more than 30 minutes, it will automatically turn off.  To 

turn the power off before this and to conserve battery power, press the “Off” button. 

 
Self-Test 

 

To verify that the system is working properly, press the Test button.  If the associated green light 

turns on, the Amplifier Unit microprocessor is working properly.  If the green light does not 

illuminate, press the OFF button, then turn the unit back on by pressing the ON button.  This will 

reset the system.   

 

In some UBA models, an error diagnostic has been added to the self-test indicator.  If the 

associated green light turns on and remains on without pressing the Test button, there may be an 

issue with the amplifier.  Please contact LKC Technologies Customer Support if you have any 

concerns. 

 

Note:  The Self-Test button does not work if the unit is turned off.  The Power / Battery Status 

indicator must be illuminated for the Self-Test to work. 

 

2.4.2 UBA 4200c Interface 

 

When the interface is plugged into the PC, the green light will turn on.  If the green light is off, 

check the connection to the PC.  In some UBA models, when the interface is transferring data 

during data acquisition, the light will flicker.  If flickering stops during data collection make sure 

the amplifier unit is turned on and connected to the interface unit.  Please contact LKC 

Technologies Customer Support if you have any concerns.   
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2.4.3 UBA-4204 Inputs 

 

UBA-4204 has 1.5 mm male DIN safety connectors (which accommodate connections to most 

electrodes).  The channel connections are indicated on the back label of the Amplifier Unit. It has 

4 differential inputs and a ground.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                     UBA-4204 Inputs (back label) 

 

2.4.4 Battery Charging 

 

The UBA-4204 Amplifier Unit is powered by an internal rechargeable Lithium-ion battery. A 

fully charged battery will allow you to collect data continuously for up to 12 hours.  The required 

time to recharge a fully depleted battery is 8 hours, with ~80% of the charge restored within the 

first 4 hours. 

If the battery is fully depleted (unit will not turn on), recharging the battery for 10 minutes 

should provide enough charge to operate the unit for approximately ½ hour. 

 

The battery charge indicator is the LED next to the Battery Check symbol on the front of the 

UBA-4204; it indicates the remaining amount of battery charge. 

 

Battery Check Symbol 

 

 

LEDs Illuminated 
Remaining Battery  

Charge 

Green > 30 % 

Green + Red 10 % - 30 % 

Red < 10 % 

 

1234

C +

Model UBA-4204
(PATENT PENDING)

Serial Number

  LKC Technologies, Inc.
     2 Professional Drive, Suite 222
     Gaithersburg, MD  20879 USA
     Phone: 301.840.1992
     Fax: 301.330.2237
     Info@LKC.com    www.LKC.com
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Warning: Do not charge the battery while the UBA-4204 Amplifier Unit is 

connected to a patient.   

 

To charge the battery, insert the Battery Charger Power Supply connector into the Amplifier Unit 

directly below the DC Power symbol and plug the power cord into a wall outlet or isolation 

transformer.  The Battery Charger Power Supply can be used with inputs from 100-240V and 

50/60 Hz.  

 

DC Power Symbol 

 

 

2.4.5 Changing The Battery 

 

The battery is designed to withstand approximately 500 discharge cycles.  As this number is 

approached, the operating time per recharge will decline.  If a new battery is required, the 

amplifier unit will have to be returned to LKC Technologies where trained personnel will install 

a replacement battery.  (Battery replacement is not covered under warranty.)  Please contact LKC 

Technologies Customer Support before returning the amplifier for this service. 

 

 

 Warning: Use only a genuine replacement battery from LKC Technologies.  

Use of other batteries may be hazardous. 
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2.5 Ganzfeld 

 

The Full-Field Ganzfeld Stimulator is connected to the system interface unit and controlled by 

the system’s computer. The UTAS system can come with either a SunBurst Ganzfeld or a 

BigShot Ganzfeld.  

 

2.5.1 SunBurst 

 

SunBurst has a compact size 13.5” W x 

10.5” D x 8” H (34.3 cm x 26.7 cm x 20.3 

cm) - 5.0 lbs (3.7 kg). It has an ergonomic 

mounting arm which provides easy 

adjustment to any patient and a quick 

disconnect feature and built-in handles for 

easy positioning over prone patient. The 

inside of the Ganzfeld can be cleaned with a 

damp cloth and mild detergent.  

SunBurst has a built in camera to monitor 

the fixation of the patient.  

 

SunBurst uses Red (627 nm), Green (530 nm), Blue (470 nm), Amber (590 nm) and white LEDs 

(for dim flashes) as well as a Xenon flash. It has a total dynamic flash luminance range of 105 

dB (+30 dB to -75 dB) in 1 dB steps. All flash durations are less than 5 ms.  

 

The xenon flash luminance range is 2.5 - 2500 cd-s/m
2
 (0 dB to +30 dB). 

 

LED flash luminance is of 2.5 • 10 
– 5

 to 160 cd-s/m
2
 (-50 dB to +18 dB) in any arbitrary color. 

LED flash luminance is of -75 dB to -50 dB in white. The background light can be controlled 

from 10
-6

 to 5000 cd/m
2
 in 0.01 dB increments in white and from 0.005 to 5000 cd/m

2
 in 0.01 dB 

increments in any color (up to 4000 cd/m
2
 in blue). The intensity tolerance increases for 

background levels below 10
-3

 cd/m
2
.  

 

The flicker stimuli goes up to +20 dB; 1 Hz repetition rate for intensities > +20 dB 

 

SunBurst also has the capability to produce long duration flash (On/Off response) stimuli 

programmable to 6.5 seconds in 5 ms increments with adjustable intensity and chromaticity. 

 

An arbitrary waveform capability is also built in using RGB stimuli to 2000 points (10 seconds) 

per cycle. 

 

SunBurst also has 9 red EOG fixation LEDs in ±15° horizontally with brightness adjustable over 

20 dB range in 1 dB steps. 

 

 

 



UTAS Hardware 

 
 

Version 2.4 17 

2.5.2 BigShot 

  

BigShot is sized to fit larger animals such as dogs, pigs, cats, 

etc. It has dimensions of 19.5” (50 cm) H x 15.5” (40 cm) W 

x 12.5” (32 cm) D and weighs 17 lb (7.7 kg).The inside of 

the Ganzfeld is not washable. Use compressed air to blow 

dust particles out. Do not use water.  

 

BigShot uses Red (627 nm), Green (530 nm), Blue (470 

nm), Amber (590 nm) and white LEDs (for dim flashes) as 

well as a Xenon flash. It has a total dynamic flash luminance 

range of 100 dB (+25 dB to -75 dB) in 1 dB steps. All flash 

durations are less than 5 ms.  

 

The xenon flash luminance range is 2.5 - 800 cd-s/m
2
 (0 dB 

to +25 dB). 

 

LED flash luminance is of 2.5 • 10 
-5

 to 25 cd-s/m
2
 (-50 dB 

to +10 dB) in any arbitrary color. LED flash luminance is of 

-75 dB to -50 dB in white. The background light can be controlled from 0.005 to 1000 cd/m
2
 in 

0.01 dB increments in any color and as low as 10
-6

 cd/m
2
. The intensity tolerance increases for 

background levels below 10
-3

 cd/m
2
. The background UV stimulation has a maximum of 500 

cd/m
2
.   

 

The flicker stimuli goes up to +10 dB; 1 Hz repetition rate for intensities > +10 dB. 

  

BigShot also has the capability to produce long duration flash (On/Off response) stimuli 

programmable to 6.5 seconds in 5 ms increments with adjustable intensity and chromaticity. 

 

An arbitrary waveform capability is also built in using RGB stimuli to 2000 points (10 seconds) 

per cycle. 

 

BigShot has 3 red EOG fixation LEDs in ±15° horizontally with brightness adjustable over 20 

dB range in 1 dB steps. 

 

BigShot has an optional UV stimulator that can be used for flash stimuli and background light to 

stimulate animal S-Cones (contact LKC if interested in upgrading to UV). 

 

2.6 Pattern Monitor 

 

The pattern stimulator is controlled by the AGP video card installed in the computer and consists 

of either a color VGA or DVI LCD or CRT monitor for Pattern VEP / Pattern ERG, or a high-

brightness monochrome monitor if selected as an option with Multi-Focal ERG/Multi-Focal 

VEP.  Commands sent by the computer to the video card produce changes in the display on the 

pattern stimulator screen.  
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The stimuli have three pattern formats: checkerboards, square wave gratings and sinusoidal 

gratings. Grating pattern stimuli can be presented vertically or horizontally. Pattern alternation 

rate can be set at 0.25, 0.5, 1, 1.66, 2, 3.8, 5, 7.5, 15, 25 or 32.5 Hz. Pattern blank can be set to 

the following on:off ratios: 16:1, 8:1, 4:1, 2:1, 1:1, 1:2, 1:4, 1:8, 1:16.  All three pattern formats 

provide red, green, blue, white and black colors (except for the high brightness monochrome 

monitor for Multi-Focal ERG testing, which is black and white only). In addition, hemifield (¼, 

½) patterns can be displayed, and the pattern contrast can be adjusted from 1% to 100%. Patterns 

can be presented in either alternating pattern or pattern blank. 

 

2.7 CMGS-1 Color Mini-Ganzfeld Stimulator (optional) 

 

The optional CMGS-1 Color Mini-Ganzfeld Stimulator consists of two units: the control box and 

hand-held mini-Ganzfeld. The CMGS-1 is controlled by the system computer via a serial port 

connection. 

 

Various color LEDs are used to produce red, green, blue, or white stimuli. The intensity of white 

flash/flicker can be set to the following levels: +10 dB, +5 dB, 0, -5, -10, -15, -20 or -25 dB, 

while color R/G/B stimuli can reach a maximum intensity of +2 dB.  The background intensity 

can be set to any of three levels for the white, red, green and blue colors. The CMGS-1 also 

provides On/Off Response stimuli with W/R/G/B color.  A dim red LED is mounted at the back 

of the mini-Ganzfeld for fixation.  

 

2.8 MGS-2 White-Only Mini-Ganzfeld (optional) 

  

The optional MGS-2 Mini-Ganzfeld consists of two units: the control box and hand-held mini-

Ganzfeld. The MGS-2 is controlled by the system computer via a serial port connection. 

 

A number of bright white LEDs are used to produce the stimulus.  The intensity of the stimulus 

can be set to +5 dB, 0, -5, -10, -15, -20 or -25 dB.  The brightness of the background light is 

fixed to 30cd/m² for flash and flicker stimuli.  A dim red LED is mounted at the back of the 

mini-Ganzfeld for fixation. 

 

2.9 Overall Equipment Interrelations 

 

Figures 1 and 2 below are the block diagrams of the system in the two versions (desktop and 

laptop), showing how the various elements of an UTAS system are interconnected. 

 

The functional paths are 

 Signal 

 Control 

 Display 

 

Signals travel from the patient to the amplifier unit where the signals are converted from Analog 

to Digital and passed on to UBA-4204 interface. In the UBA-4204, the data is converted and sent 

to the computer via USB 1.1 connection to the computer. The computer collects signals for 

digital amplification and filtering, averaging, computing, display, and analysis. 
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The user utilizes the mouse and keyboard of the computer while the computer controls the 

pattern monitor stimulator, Ganzfeld or Mini-Ganzfeld, and amplifier unit. 

 

There are three displays in the system: the computer operator display, the pattern monitor 

stimulator display and the printer. The operator display is controlled by the added video card; the 

pattern monitor is controlled by the video board that is already on the computer motherboard. 

The printer is connected via a USB connection. 
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Ref. ID Description 
Length 

(m) 
Manufacturer Manufacturer Part Num. 

W1 AC Input Power Cord 2.4 VOLEX INC 17031 8 S2 

W2 – W8 Power Cord 1.5 INTERPOWER 86557040 

W9, W10, W15 USB Cable 2 GENERIC USB-1037-2.0-6-BK 

W11, W13 Serial Cable 1.8 
BEST 

AVAILABLE 
LKC 91-172 

W12 Ganzfeld Cable 2.4 LKC LKC 91-183 

W14 Fiber Optic Cable 2 LIFA TEC USA POF TOCP255K 

List of cables used in UTAS (desktop) 

 

 

Ref. ID Description Length (m) Manufacturer Manufacturer Part Num. 

W1 AC Input Power Cord 2.4 VOLEX INC 17031 8 S2 

W2 – W7 Power Cord 1.5 INTERPOWER 86557040 

W8, W9, W14 USB Cable 2 GENERIC USB-1037-2.0-6-BK 

W10, W12 Serial Cable 1.8 
BEST 

AVAILABLE 
LKC 91-172 

W11 Ganzfeld Cable 2.4 LKC LKC 91-183 

W13 Fiber Optic Cable 2 LIFA TEC USA POF TOCP255K 

       UTAS Cable List (Notebook) 

 

Warning: The use of cables other than those specified in these lists may result in increased 

emissions or decreased immunity of the UTAS. 
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3.0 Setting Up the System 

 

3.1 Inventory 

 

The UTAS testing system consists of a system interface unit, an amplifier unit, a pattern 

stimulator, a Ganzfeld and/or a mini-Ganzfeld stimulator with a control unit, and a computer 

with its associated peripherals.  The equipment should be arranged on workstations or tables. 

 

Make sure that the patient location is as far as possible from power mains or electromagnetic 

devices to minimize 60 or 50 Hz electromagnetic interference.  Additionally the patient should 

not be seated where he or she can be touching the Interface Unit or other electrical apparatus 

during testing. Therefore, the Pattern Stimulator and Ganzfeld Stimulator should be placed on 

the instrument table that does not contain the Interface Unit.  The best arrangement for the UTAS 

system is where interface unit and Computer Unit are placed on one workstation and the 

Stimulators on a separate instrument table as follows: 

 

    A.  Operator's Station on workstation 

Computer  

Operator Monitor 

Keyboard  

Mouse 

Printer 

UTAS Interface Unit 

UBA-4204 Interface Unit 

 

    B.  Instrument/Patient's Station 

Video Pattern Stimulator 

Ganzfeld or Mini-Ganzfeld Stimulator with control unit 

 

Note: The amplifier unit is not listed on either station.  It will be worn by the patient during 

testing. 

 

3.2 Precautions 

 

3.2.1 Power Main Interference 

 

The principal external interfering signal is electrical noise generated by power lines or by 

electrical equipment connected to power lines.  The typical electrical outlet provides a ready 

source of 110-220 Volts, which is about a million times greater than the amplitude of the ERG.  

Examples of equipment that generate electrical interference include fluorescent lights, motors 

(including motorized chairs), and power transformers.  Power transformers radiate primarily 

third harmonic (e.g., 180 Hz).  These items produce powerful electromagnetic fields that can 

induce or couple power line interference into the recordings.  The closer the patient and the 

equipment are to these sources, the more interference will be introduced into the recording 

equipment.  LKC’s revolutionary Universal Biomedical Amplifier will cancel most of this 

interference; however, if the patient leads or amplifier are close enough to power lines or 
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electrical equipment, power mains interference may be seen in the recordings.  Therefore, care 

should be taken to locate the testing equipment and subject away from any major source of 

electrical interference. 

 

3.2.2 High Frequency Electrical Noise 

 

Beyond the power lines or equipment such as motors and transformers, electrical noise can be 

produced by equipment generating noise at radio frequencies.  Although one might expect such 

signals to be filtered out by the amplifier filters, it is possible for this type of noise to generate 

low frequency artifacts by nonlinearities in the recording equipment and by mixing with other 

signals.  Therefore, care should be exercised to keep the recording equipment and subject away 

from strong sources of radio frequency interference. 

Noisy signals can come from nearby MRI systems. This will create noise and/or unrecordable 

data.  

 

 

3.2.3 Shielding 

 

If a location which is free of interfering apparatus cannot be found, it is possible to create simple 

shielding which can usually control the interference.  A shielding material, such as copper or 

aluminum can be placed below the patient and covered with an anti-static mat or placed around 

interfering apparatus.  The screen and mat, if used, should be securely connected to electrical 

ground. 

 

3.3 Equipment Interconnections 

 

The equipment is interconnected as shown in Figure 1 for a desktop version of the UTAS system 

and Figure 2 for a laptop version system. Make certain that the power is off before making any 

connections. All of the equipment in your UTAS must be connected for the system to function 

properly. 

 

Computer to Operator’s Monitor.  The desktop system version comes with connections for 

two monitors.  They will be labeled User’s Monitor and Pattern Monitor. Plug the operator’s 

monitor into the connection labeled User’s Monitor. 
 
Computer to Pattern Stimulator.  Plug the pattern monitor into the connection labeled Pattern 

Monitor. 
 

Computer to Printer.  Plug the printer into the labeled USB connector on the computer’s rear 

panel using a standard USB cable. 

 

Computer to Keyboard. A cable connects the keyboard to the computer.  The keyboard end is 

permanently attached; the computer end is a plug that can connect to a receptacle or to a USB 

connector on the back of the computer. 
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Computer to Mouse.   A flexible cable connects the mouse to the computer.  The mouse end is 

permanently attached; the computer end is a plug that can connect to a receptacle or to a USB 

connector on the back of the computer. 

 

Computer to UTAS System Interface Unit.  A serial port extension cable connects the 

computer to the UTAS system interface unit. The female end goes to the 9-pin RS232 connector 

on the back of the computer, and the male end goes to the interface rear panel.  A USB cable 

connects into the back of the interface unit.  The other end connects to the labeled USB port on 

the computer. 

 

UBA-4204 to UBA-4204 Interface Unit.  Connect using a fiber optic cable (TOSlink). The two 

ends are interchangeable.  

 

UBA-4204 Interface Unit to Computer. Connects via USB 1.1 cable to the back of the 

computer.  

 

WARNING: The USB cable should be in the USB port that was specifically 

labeled for the interface unit. If the USB cable is plugged into another USB 

port, the computer won’t recognize the device. 

 

 

System Interface Unit Ganzfeld (SunBurst or BigShot).  An 8 foot, fiberglass-sleeved cable 

connects the Ganzfeld’s interface to Ganzfeld. The 16-pin plastic connector on the cable goes to 

the back panel of the system interface unit. 

 

Computer to CMGS-1/MGS-2 Control Unit (optional).  If the optional CMGS-1 or MGS-2 is 

included with the system, then a splitting serial cable will be furnished. The female end of this 

cable goes to the 9-pin RS232 connector on the back of the computer, while one of the two male 

ends goes to the interface rear panel, and the other goes to the CMGS-1 or MGS-2. 

 

CMGS-1/MGS-2 Control Unit to Color/White Mini-Ganzfeld (optional) The Control box 

end of the mini-Ganzfeld cable has a 25-pin connector, which connects to the rear panel of the 

box. The other end is permanently attached to the hand-held mini-Ganzfeld head. 

 

Power Connections.  The equipment requiring connections to AC power of the MGIT include: 

 

 Computer 

 Computer Monitor or AC/DC Adaptor if LCD Monitor is used and DC powered 

 Printer or AC/DC Adaptor for Printer 

 Pattern Stimulator Monitor 

 System Interface Unit 

 Battery Charger for Patient Amplifier (UBA-4204) 

 CMGS-1/MGS-2 Control Unit (optional accessory) 
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An isolation transformer (MGIT-100) is included to provide additional isolation from the 

power line ground system.  The transformer will limit leakage current to inconsequential 

levels should there be a failure in the grounding system. 

 

NOTE: The Transformer is required to limit the leakage current to 

established safe levels if there is a failure in the grounding system.  No part of 

the system, except the Isolation Transformer Unit, should be plugged into an 

A.C. primary (wall) outlet.  Other subsystems should be connected to the power 

receptacles on the Isolation Transformer Unit.   

 

The MGIT-100 should be plugged directly into a designated wall outlet, and not through an 

intermediate power strip. 

 

--------------------------------------------------------------------------------------------------------------------- 

 

WARNING: The installation of any software on the UTAS Windows based computer that 

is not provided directly by LKC can cause the system to stop functioning, crash 

unexpectedly, or disrupt the timing of the stimulus presentation and data collection.   

 

 

The LKC UTAS Visual Electrophysiology System is a precision standalone medical device.  The 

computer provided with the system has been specifically manufactured and configured for this 

specific purpose.  It is absolutely essential that the timing of the stimulus presentation and data 

collection not be impeded by any non-LKC provided software products.   

 

The warranty on the UTAS system does not cover problems caused by installation of non-

approved software on the computer. The UTAS system is a medical device that uses a Windows-

based computer.  Installation of additional software on the UTAS computer may result in 

improper operation of the UTAS system. It is the customer’s responsibility to ensure that any 

additional software installed on the UTAS computer does not affect the performance of their 

UTAS system.  LKC is not liable or responsible for improper operation of the UTAS system 

caused by customer-installed software.   

 

Therefore, LKC strongly recommends that the system be used as a standalone medical 

device. LKC also strongly recommends that: 

1. The user does not change any user privileges or software settings.   

2. No non-LKC approved software products be installed on the system 

IMPORTANT 
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4.0 Before System Use 

 

The UTAS system comes with a PC that contains a hard disk drive.  All of the UTAS software 

has been installed on the hard drive, and the recordings will be stored on the hard drive as well.  

Unfortunately, hard disk drives sometimes fail, and when they do, there may be no way to 

recover the lost information.  For this reason, it is recommended to occasionally backup all 

important information on disks.  

 

In addition to the UTAS software on hard disk, the software program, EMWin (as well as the 

MFERG/MFVEP, if applicable) is supplied on one CD-ROM.  This is a backup copy in the event 

that the program on your hard disk becomes corrupted.  As a precaution, an additional backup 

copy of this disk may be made using the rewriteable CD-ROM drive on the system computer. It 

is recommended that a copy is kept near the UTAS system, and the original is stored in a safe 

place, preferably in another location. 
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5.0 Checking UBA-4204 (Amplifier) Response 

 

Using the black plastic VerifEye box that was shipped with the system, it is possible to check if 

the UBA-4204 is working properly.  

 Plug the box’s red wire into channel 1+ and the black wire  into channel 1- 

 Turn the switch on the box up for ON 

 Gently place the box in the Ganzfeld to avoid scratching the paint 

 Turn UBA-4204 ON 

 On the computer, start EMWIN -> Perform Test -> ERG -> Standard ERG 

 Go to step 2 (0dB scotopic flash) 

 In SunBurst Parameters turn the IR LED OFF (Skip this step for BigShot as it 

doesn’t have IR LEDs) 

 Click on Baseline and Record – Stop Baseline and then Record 

 Once the test is finished,  remember to turn the IR LED back ON 

 Turn switch OFF 

 

The Ganzfeld will deliver a 0 dB flash that will trigger the photo sensor of the pulse box and 

should show as a 150 µV ± 5% pulse of 35 ms width (see picture below). The IR LEDs are 

automatically turned on as the system is powered up. They are used in conjunction with the mini 

webcam to see the eyes of the patients in the dark while recording. The IR LEDs, however, 

saturate the photo sensor of the check box; hence, they need to be turned off while checking for 

the pulse.  
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6.0 Checking Ganzfeld Calibration (for SunBurst and BigShot) 

 

6.1 Overview 

 

The UTAS with SunBurst comes with a calibration checking application. Original calibration 

values are stored in the memory of the system. The calibration check software allows the user to 

check new calibration measurements and compare them to the original factory calibration data. 

Note that there is no way for the user to calibrate any of the light sources; the unit needs to be 

returned to the factory if such recalibration is determined to be required. Also note that this 

application is NOT available for BigShot. 

 

SunBurst and BigShot have three different light sources that are used for background and/or 

flash purposes. Those include dim white LEDs, the red/green/blue LEDS, the amber LEDs and 

the Xenon Flash.  

 

Light Source Used for 

Background Light 

Used for Flash 

Dim White LEDs Yes Yes 

Red, Green, Blue LEDs Yes Yes 

Amber LEDs Yes No 

Xenon Flash No Yes 

 

             

Calibration check should be performed in a dark room with the Ganzfeld cover on. Also make 

sure that the fixation LED is turned off during calibration. 

 

 

The photometric measurement of most relevance to clinical electrophysiology is the luminance. 

Luminance is a measure of light per unit area emitted from an extended source or reflecting 

surface. This measure is independent of distance. Intuitively, one can think of luminance as 

roughly equivalent to brightness, and as an object is approached, its brightness does not change 

appreciably. The Système Internationale (SI) unit of luminance is the candela per square meter 

(cd/m
2
). The relation between this measure and older measures of luminance is shown in Table 1 

below. For brief flashes of light, such as those used for the flash ERG and VEP, the luminance of 

the stimulus must be weighted by flash duration, since temporal integration of the neuronal 

visual pathways is longer than the duration of the flash. Thus, the appropriate unit of time-

integrated luminance for brief flashes of light is cd-s/m
2
. 

 

IMPORTANT 
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Table 1: Luminance Conversion Factors 

 

Another measure of importance to clinical electrophysiology is retinal illuminance, an estimate 

of the effective stimulus at the retina. The standard measure of retinal illuminance is calculated 

by multiplying stimulus luminance by pupillary area. The unit of retinal illuminance is the 

Troland (td). 

 

The Troland is defined as the retinal illuminance obtained when a stimulus of 1 cd/m
2 

is viewed 

through a pupillary area of 1 square mm (diameter of 1.128 mm). Scotopic Trolands (td’) can 

also be measured using V’λ to calculate stimulus luminance. 

 

Flash intensities are often referred to in decibels (dB). The term dB is a relative one, as shown in 

the equation: 











)0(

)(
log10

I

xI
dB  

Where I(0) is the intensity at 0dB and I(x) is the intensity at x dB. The intensity at 0 dB for all 

ganzfelds is 2.5 cd-s/m
2
.  

 

6.2 Checking Calibration Using Zenith Software (for SunBurst Only) 

 

Zenith software will allow the user to run a calibration check. It will measure values of all of the 

SunBurstSunBurst light sources 10 times and alert the user if the value varies from the initial 

factory calibration value. If there is more than 1 dB difference in calibration values please 

contact LKC Technologies.  

Note: This is not available with the BigShot Ganzfeld.  

 

Follow the instructions displayed by the Zenith prompt 
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Step 1: SunBurstSunBurst ON with cover, Lights OFF            Step 2: Click on Test Ganzfeld 

 

Step 3: Review Calibration Values 
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6.3 Checking Calibration On Your Own 

 

In order to check calibration, the following is required: 

 A Model 2550 Digital Radiometer/Photometer for calibrating the dim white flashes as 

well as the Xenon flashes. Other photometers are acceptable for calibration if they 

measure light intensity in either candelas per square meter (cd/m
2
) or in foot-Lambert 

(ft-L). The photometer must also be capable of integrating its response to measure 

candela-seconds per square meter (cd-s/m
2
) or foot –Lambert-seconds (ft-L-s).  

Conversion:    Lft
m

cd
1426.3

2
 

 A CS-100 Minolta Chroma Meter to check calibration of the Red, Green and Blue 

LED flashes and background (0-5000 cd/m
2
) and the Amber background.  

 

6.3.1 Checking Calibration of Dim White LED 

 

In order to check calibration for the dim white flashes, the DR-2550 should be used in 

integrating mode. The dim white LEDs have such low luminance that they have to be integrated 

over a large period of time.  

 Place the photometer probe pointed at the back of the Ganzfeld and set it to integrating 

mode 

 Set background light to -50 dB 

 Turn off the lights and cover Ganzfeld with its cover.  

 Measure background light 

 

6.3.2 Checking Calibration of Xenon Flash 

 

In order to check calibration for the dim white flashes, the DR-2550 should be used in 

integrating mode. 

 Place the photometer probe pointed at the back of the Ganzfeld and set it to integrating 

mode 

 Turn off the lights and cover the Ganzfeld with its cover.  

 Fire the Xenon flash at 10dB and measure in ft-L-s  

 

6.3.3 Checking Calibration of Color LEDs 

 

In order to check calibration for the color LEDs, the CS-100 Chroma Meter is needed.  

Colors green, red and blue LEDs are used for background light and flash. It is fair to assume that 

if the calibration of intensity and color coordinate is correct for background light, it will also be 

correct for flashes.  

 Set the background light of Ganzfeld to the coordinate that is to be measured (intensity 

and x, y coordinate for color) 

 Turn lights off 

 Place the Chroma Meter inside of the Ganzfeld, making sure the image is in focus and set 

on cd/m
2 
 

 Read measurement and compare it to the intensity and color coordinate desired. 
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6.4 Replacing Background or Flash Lamps/LEDs 

 

LEDs and Xenon tubes can only be changed in factory at LKC Technologies, Inc. Please contact 

the LKC support line to get information on how to send your system.  
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7.0 External Triggers (Input and Output) 

 

 

The rear of the LKC Interface Unit contains two BNC connectors labeled Trigger In and Trigger 

Out. These connectors allow for the connection of external stimulators to the UTAS system. This 

section will provide some information necessary to connect external stimulators to the UTAS 

system. 

 

Trigger In and Trigger Out are default to positive going TTL unless specified otherwise at time 

of purchase. Contact LKC for information on how to change trigger polarity.  

 

 

7.1 Triggering External Equipment – Trigger Out 

 

The BNC connector marked Trigger Out on the back of the Interface can be used to trigger an 

external piece of equipment. The trigger signal is a positive going TTL compatible output of 

approximately 1 ms duration.  

 

A signal appears at the Trigger Out BNC whenever SunBurstSunBurst or BigShot produces a 

flash. In case of an ON/OFF response, the trigger will go low at the start of the stimulus and will 

go high again once the stimulus is over.  

 

Note that the Trigger IN should be providing the voltage through a 1k resistor to the UTAS 

Interface. 

 

 

7.2 Receiving Triggers from External Equipment – Trigger In 

 

If you have a stimulator that can provide a trigger signal to the UTAS Interface, data may be 

recorded using that stimulator. The BNC connector marked Trigger Out on the back of the 

interface can be used to receive triggers from an external piece of equipment. Note that the 

Trigger IN should provide the voltage through a 1k resistor to the UTAS Interface. 

 

Please contact LKC Technologies, Inc. before connecting any external 

equipment to the Trigger In or Out connector of the Interface Unit. 

 

Warning If the stimulators are not connected properly to the Interface Unit, 

damage may result to either the Interface Unit or to your stimulator. If there are 

any doubts, please contact LKC before proceeding.  
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8.0 Cleaning The System Between Patients 

 

8.1 Cleaning Reusable Burian-Allen Contact Lens Electrodes 

 

Clean the electrode with a 50/50 mixture of liquid Tide detergent (or any mild detergent) and 

distilled water (note that letting tears dry on the lens after testing makes them very difficult to 

remove!).  The water used to soak them should not be acidic (i.e. “hard” water), as it will cause 

the electrolysis between the solder (tin/zinc), which will turn the silver black.  If left over a 

weekend it will fall apart and have to be reconditioned.  The electrode may then be rinsed off 

with tap water.  Rinsing will not cause electrolysis, as soaking for extended periods of time in 

hard water will. 

After cleaning the Burian-Allen electrode, it can be disinfected with 1:10 bleach method for 5 

minutes (no longer).  Using the same soapy water mixture, the silver on the electrode can be 

scrubbed lightly with a toothbrush (only the silver, make sure not to scrub the wire spring).  This 

should be followed by a thorough rinse.  Note that the electrode should not be exposed to the 

bleach for more than 5 minutes (longer can cause the silver to turn brown), and the concentration 

of the bleach should be 0.5%, not 5% (straight Clorox is 5.25%).  Also note that some 

deterioration of the electrode will occur over time, even when this method is used properly. 

The Burian-Allen electrode can also be disinfected with activated dialdehyde (Glutaraldehyde), 

sold under the trade names Cidex, CabcoCide and Sporcide.  All of these will have usage 

instructions on the containers, which should be followed.  Note that LKC quality control 

engineers have soaked the electrode in activated dialdehyde for over 4 days and noticed no 

visible effects. 

 

A third method of disinfecting is to use Ethylene Oxide at 125 degrees Fahrenheit.  The heat will 

not harm the electrode. 

 

To check the electrode for damage, check the ring, the speculum inner edge, the speculum outer 

edge, the speculum surface, and the lens edge (for chips).  If the electrode is damaged and needs 

repair, please contact LKC. 

 

Note: ERG-Jets and DTL electrodes are disposable. This cleaning method does NOT apply to 

them.  

8.2 Cleaning the Forehead Rest 

 

The patient’s forehead will come into contact with the Ganzfeld forehead rest during testing.  

The forehead rest should be cleaned and disinfected between uses to prevent the spread of skin 

infections. 

 

The simplest method of cleaning and disinfecting the forehead rest is to wipe it thoroughly with a 

70% isopropyl alcohol solution.  Using a disinfecting wipe is a good way to do this.  You may 

also clean the forehead rest using a glutaraldehyde solution.
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9.0 Introduction 

 

The software permitted to run the system is called EMWIN; it handles all of the details of 

performing a test – presenting a stimulus, collecting and analyzing the data, storing results, and 

printing a report. This section of the manual details the use of the EMWIN software system, 

version 9.4.0. 

 

This manual assumes familiarity with the basic operations of Windows XP
®
.  If this is not the 

case, please refer to the manual that came with the computer. 

 

 

10.0 Using the System 

 

10.1 Starting and Quitting the System 

 

To start using the system, first turn on the power of the MGIT-100 (Medical Grade Isolation 

Transformer). Then make sure all peripherals are on (pattern monitor, printer, user monitor, 

CMGS-1/MGS-2 if applicable), and turn on the computer.  

 

Once the computer boots the EMWIN software will automatically open up to the main menu.  

 

To turn off the system click on QUIT in EMWIN main menu, turn off the computer by going to 

Start -> Turn OFF Computer -> Turn OFF.  

 

Once the computer has powered down, power off the MGIT-100 this will turn all the peripherals 

off as well.  

 

10.2 The Main Menu 

 

The Main Menu is used to access 

all of EMWin’s features.  The four 

sections are Perform Tests, Create 

Reports, Design and Manage 

Protocols and Utilities. 

 

While the Protocols or Utilities 

functions may not be used on a 

daily basis, it is still necessary to 

understand their functions. 

 

TESTS: Clicking on this button 

will allow the user to perform all 

visual electrodiagnostic tests that 

the instrument is configured for.  

This segment of the program 
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allows for the collection and storage of data and will be the most frequently used function of 

EMWin. 

 

REPORTS: This module allows the user to not only print reports, but also analyze the data.  

Stored data can be recalled and displayed before being analyzed and the reports printed out. 

 

PROTOCOLS: EMWin allows the user to design their own testing protocols.  This part of the 

program allows for the specification of the individual parameters to create specific protocols. 

 

UTILITIES: This section of the program allows the user to change the practice information, edit 

data and databases, and change the system setup. 

 

10.3 Setting Preferences in Utilities  

 

Although the software and hardware for the LKC Visual Electrodiagnostic Test System are, for 

the most part, set up at the factory before shipping, there are a few tasks that must be performed 

to complete the setup procedure. 

 

10.3.1 Entering the Report Header 

 

EMWin will print out up to four lines of 

text at the top of each printed report. This 

text is normally the name and address of 

the practice, but it may be any other four 

lines of text wanted. In order for EMWin to 

print out this information, the information 

must be provided in this section.  

 

From the Main Menu, click on Utilities and 

choose Change Practice Information. A 

Text Fill-In menu will appear that will 

allow the user to specify the name and 

address to appear at the top of the report. (If this information is left blank, no information will 

be printed.) Each line may have no more than 32 characters in it, so plan the header carefully. 

Because this information will appear at the top of every report that is printed, make sure that 

there are no errors. 

 

10.3.2 Creating the Storage Database 

 

EMWin allows for the creation of Access databases in which waveforms can be stored. All of 

the waveforms in one database are hidden from the waveforms in other databases. One method 

for organizing the files is to create different databases to store them. EMWin will allow the user 

to specify which database is to be used to store and retrieve waveforms. All of the waveforms in 

this database are unique and different from those in other databases. For example, it is possible to 
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have several subdirectories called data2007, data2008, data2009, etc. Waveform number 1 in 

data2008 is totally unrelated to waveform number 1 in data2009. 

 

Although each database can theoretically hold an unlimited number of waveforms, the search 

performance of the computer slows when there are more than a few thousand waveforms in a 

single database. Therefore, it is recommended to take some time to decide how to organize the 

storage of waveforms. Depending on how many waveforms will be recorded per month, there 

can be different database for each month or each year, or per different studies… 

 

Select Utilities from the Main Menu, and then choose Create New Database and Standard 

Database from the popup menu.  A screen will then allow for the naming of the new database.   

 

NOTE: The database should only contains letters A-

Z or a-z and/or numbers 0-9 (no spaces allowed) 

 

Once the database has been created, don’t forget to 

select it to start storing waveforms in the created 

database. See the next section for selecting a database.  

 

10.3.3 Selecting the Storage Database 

 

EMWin allows the user to store waveforms in different databases.  To select which database to 

work with, select Utilities from the Main Menu.  Choose Select Database and Standard 

Database from the popup menu.  A screen appears that lets the user choose the database desired 

and also informs them of the current database.  This selection determines the location where test 

data will be stored, as well as which database 

will be called when reports are created.  

EMWin’s Main Menu automatically displays 

the current database in use.  
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10.3.4 Selecting the Date Format 

 

The date format is defaulted to MM/DD/YYYY; however, the date format may be changed to 

DD/MM/YYYY by going into Utilities and System Set-Up.  

 
 

10.3.5 Selecting the Screen Size 

 

The software can be matched to the current screen resolution to maximize the waveform 

display. See preferences window in section 10.3.4 

 

10.3.6 Selecting the OP Filter 

 

The software can be used with custom OP filters.  The software is preloaded with the following 

OP filter frequencies: 45 Hz (Mouse), 75 Hz (Human), 100 Hz, 125 Hz, and 150 Hz.  To use 

any of the filters, select them from the dropdown list (see preferences window in section 10.3.4).  

If user defined filters would like to be used (up to 500 Hz), simply type in the drop down box 

the filter frequency desired. 

 

10.4 More on Utilities 

 

Initial set up of preferences for Practice Information, Database and Date format are covered on 

section 10.3.  

 

The next section of the manual will be 

devoted to covering the remainder of the 

Utilities menu. 

 

 



UTAS Software 

 
 

Version 2.4 40 

 

 

10.4.1 Backing Up Databases 

 

Utilities -> Database Tools -> Backup Current Database. It is good practice to frequently 

backup the data. How often depends on how much data is willing to be lost. To backup a whole 

database, go to Utilities -> Backup Database. Select the database to backup (the currently used 

database is displayed on the bottom part of the main menu).  

 

Highlight the database to be backed up and then select which location it should be saved in by 

using the “save in” dropdown list at the top (CD, USB dongle…). The data can be burned onto a 

CD or copied to a memory USB dongle.  

 

10.4.2 Editing a Database / Patient Information 

 

Utilities -> Database Tools -> Edit Current Database. It’s possible to change the information 

in the database; to delete waveforms and edit patient information. For example, if a patient was 

tested and the patient’s last name was accidentally misspelled, the problem can be fixed by  

going to edit current database, finding the waveform of the patient (by using the waveform 

number) and clicking on edit patient information. There, it is possible to edit: first name, last 

name, date of birth, label of the eye (R, L, OD, and OS), diagnosis and comments. Then proceed 

to the next waveform that needs editing.  

 

10.4.3 Editing the Diagnosis List  

 

When entering the patient information, it is possible to select a diagnosis to associate with the 

patient data. A new diagnosis can be selected from the drop down list or typed directly in the 

patient information window (the program will automatically add to the diagnosis list). However, 

if you need to edit or delete some of diagnosis you will need to go to Utilities -> Edit the 

Diagnosis List.  

 

10.4.4 System Preferences 

 

The following can be changed to the system preferences: 

 

Print Font Style (Difference Row) - This specifies the difference row of the cursor printout in 

bold or italic. Note that the choice is possible only when Print Cursor with Label is not checked 
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Print Cursor with Label 

If “with label” is not selected then labels will not be able to be placed on the cursors. If it is 

selected, the labels will appear next to the cursors on the printout.  

 

If “save to file” is selected, then the cursors labels will be saved. Each time the cursor window is 

opened, the last label entered will automatically be written in the label area.  

 

Remote 

This would enable the remote function. 

This will allow the user to automatically 

step through steps of the protocols (any 

of the standard protocols or one of the 

user defined protocols).  

 

 

This function has to be used wisely, if 

not enough time is given for the 

recording to occur or to save, the remote 

function will not work properly  

 

 

 

 

System Setup contains all information specific to the system and should not be changed unless 

indicated by an LKC Technologies engineer. 
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10.5 Performing a Test 

This section covers procedures that are common to all tests run using the UTAS. 

 

10.5.1 Selecting a Test 

 

To perform a test with the EMWin system, click on Tests from the Main Menu, and choose the 

test to be performed. The options are: 

 Electroretinogram 

 Electro-oculogram 

 Visual Evoked Response 

 User Defined Protocol 

After the type of test that you wish to 

perform has been selected, another menu 

will appear asking for the specific test to 

perform. Click on the appropriate test from 

that menu. 

 

 

10.5.2 Patient Information 

 

After the test has been chosen, EMWin will provide a screen to enter patient information.  

It is important to stay consistent in the format of entered information, otherwise, data analysis 

and retrieval could be more difficult.   

 

If more than one test is going to be run, the demographic information from the last patient tested 

will appear as the default values for the next test. To clear this information, simply click on the 

Clear button at the bottom of the menu. This will delete all information and allow new patient 

information to be stored. Fill in all of the items deemed appropriate (it is not required that all 

fields be filled). 

 

Depending on whether the test subjects are animals or humans, there can be two different patient 

information windows. EMWin is defaulted to the human information window. If the animal 

version is required, go to My computer -> C:\EMWIN, open the temp folder, and rename the 

file Animal_Demographics.txt to Demographics.txt.   
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When the data is retrieved after testing, the patient information entered can be used to make data 

retrieval easier. The searchable items are marked with an asterisk. (
*
) 

 

Last Name*, First Name*, Middle Initial* - The first letter of names does not have to be 

capitalized, since EMWin will automatically capitalize them when data is stored.  There is space 

for 16 characters in both Last Name and First Name and 2 characters in Middle Initial. 

 

Sex* and Birthdate* - The Sex field should be entered with either M or F.  The Birthdate field 

should be in the following format: MM/DD/YYYY. See section 10.3.4 on instructions how to 

change the date format to DD/MM/YYYY. EMWin will flash an error message if the Birthdate 

is incorrectly formatted. Note that if an impossible date (such as 02/32/1975) is entered, EMWin 

will not alert the user. 
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Identification* - There is space for 16 characters in the Identification field. Any alphanumeric 

combination can be used for this information.  It could be the patient’s Social Security number, 

or their medical ID code. 

 

Pupils Dilated - Record in this field whether the patient’s pupils were dilated with mydriatic for 

this test.   

 

Diagnosis - A diagnosis can be typed into this field or choose one from the pull-down menu. The 

typed diagnosis will be automatically remembered and added to the list.  The list can be edited to 

add or remove or correct spelling by going into Utilities and Edit the Diagnosis List (see 

section 10.4.3). 

 

Electrode Type - For ERG testing, choose the type of the electrode used in the test from the drop 

down list. 

 

Dark Adapt Time - Record the amount of time that the patient was dark adapted before ERG 

testing.   

 

Other* - This field allows any additional information to be recorded. When the records are 

retrieved, this field is searchable. Thus, it may be useful for recording information such as 

participation in studies. 

 

Database – This window show the current database where the data will be stored. Another 

database can be selected from the pull down menu. However, to permanently store the data in a 

database other than the one defaulted; it must be changed in the Utilities tab. Refer to section 

10.3.3 for instruction on how to “Select the Storage Database”.  

 

Comment - Enter comments here about the patient that will be stored with the data.  There is no 

restriction in length. Typical comments might include symptoms the patient presented with, 

referring physician, or classification in a study group. 

 

The “Continue” button -When you have completed all of entries, click on this button to 

continue. 

 

The “Cancel” button - This will return the screen back to the main menu. 

 

The “Clear” Button - This will clear out all of the information in the fields. 

 

The “Search + Fill” button – This will search the current waveform database for matches. Fill in 

the patient’s Last Name and click on this button. If the system finds a match, it will fill in the 

remaining items based on the information stored in the database.  If no matches are found, a 

notice will appear, and the information may be entered manually.  
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10.5.3 Channel Information 

Once the patient information has been entered, click the continue button, and the channel 

information menu will appear. Select the number of channels to be recorded from and place the 

Label for each channel.  

 

The software defaults R in channel 1 and L in channel 2 for ERG and Oz in channel 1 for VEP. 

Note that for VEP testing you will also need to select the eye to be tested.   

 

 
 

 ERG VEP 

 

If only one eye is tested, channel 1 should be used regardless  

of which eye is being tested.  

 

 

10.6 Icons and Menus 

 

10.6.1 Parameters 

 

By clicking on parameters in the upper menu bar or the large A icon, or the light bulb icon, the 

parameter window will open.  

 

 

 

 

 

The parameters window contains four tabs: SunBurstSunBurst Flash, Averaging, Amplifiers and 

Timebase. 

 

SunBurstSunBurst/BigShot Flash Parameters 

 

This window allows the user to change the flash color, intensity, flicker rate as well as the 

background light intensity and fixation light.  
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There are 4 different options for the Ganzfeld flashes:  

1. Single Flash 

2. Double Flash 

3. Flicker 

4. On/Off 

 

The range of the intensities depends on the stimulus source (LED, Xenon or UV if applicable) 

For LED flashes, the x, y coordinate of color can be entered according to the CIE color diagram 

below. Note that only colors within the inner triangle can be achieved.  
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  CIE Color Diagram 

In order to produce: 

- Pure red LED stimulus enter x = 1, y = 0 

- Pure blue LED stimulus enter x = 0, y = 0 

- Pure green LED stimulus entre          x = 0, y = 1 
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Pattern Parameters 

 

 
 

In the case that a pattern stimulator is being used, the icons above will appear. The Checkerboard 

icon will open the pattern parameters. 

 

Seconds of Pre-Adapt specifies how long the pattern will alternate before the actual recording 

starts. 
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Averaging Parameters 

 

 
 

 

The Averaging Menu will appear, allowing the modification of the following options: 

 

 Number of sweeps to average 

 The number of seconds to delay between sweeps.  At least 5 - 10 seconds between flashes 

is necessary for scotopic testing to avoid light-adapting the subject during averaging.  To 

manually reject waveforms, it is recommended that this be set to at least 2 seconds. 

 Number of sweeps to acquire between screen displays of averaged waveform data. 

 Threshold for rejecting artifacts.  This option allows automatic rejection of waveforms 

during averaging that exceed an amplitude criterion.  If zero is entered, the artifact reject 

option is disabled.  If the artifact reject threshold is set to a value that is higher than the 

input range of your chosen amplifier gain setting, EMWin will instruct the user to lower 

the artifact reject threshold.   



UTAS Software 

 
 

Version 2.4 50 

 Whether or not to display each waveform as it is acquired.  For single flash ERGs, each 

response is usually viewed as it is generated.  However, for VEP tests, each individual 

response is typically meaningless since it is usually embedded in noise.  To manually 

inspect waveforms and reject them individually, each waveform must be displayed as it is 

acquired. 

 Store individual sweeps.  Typically, EMWin only stores the final average of all sweeps 

from one test, and the raw responses that make up the average are discarded.  If Store 

Individual Sweeps is selected, all raw responses will be stored in the database as well 

(up to 30 responses).  In Report mode the raw responses be included or rejected from the 

averaging process. Using this feature adds an additional step of manually choosing each 

response when preparing reports. 

 

Setting any of these parameters to “0” disables that option. 

 

Amplifier Parameters 
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This selection is used to change the amplifier gain or filter settings for the protocol.  

 

If the default values of the High Cut and Low Cut filters are changed, the 

waveform may significantly be altered. 

 

The “Notch Filter” will selectively reduce 60 or 50 Hz powerline interference.  Typically, 

excessive powerline interference can be reduced by better electrode placement or by moving the 

patient away from powerline sources.  However, the notch filter can be turned ON if all other 

noise reduction techniques fail. 

 

Timebase Parameters 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Sample Rate and Sweep Frequency - This screen allows the user to control the 

sampling frequency (default is 2 kHz).  This sample rate can be entered in Hertz or in 

Sweep length (milliseconds).  A single recording sweep always includes 512 samples.  
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If the Sample Rate is changed, the Sweep Length will automatically be updated and 

visa-versa. 

 

 

 Pre-Stimulus Baseline - A Pre-Stimulus Baseline allows the user to adjust the amount 

of data to be collected before the stimulus is presented.  Typically, this is used to 

indicate the amount of baseline noise present just prior to a flash stimulus.  

  

A “Pre-Stimulus Baseline” cannot be entered when performing a flicker test 

and the software will automatically set this parameter to 0 if attempted. 

 

EOG Parameters 

 

Brightness - If the patient is having trouble seeing the Red LEDs, the brightness of the LEDs can 

be set to a higher setting.  

 

Duration - The duration of the recording time is 15 sec, meaning that the LEDs will alternate 

from right to left for every first 15 sec of each minute.  
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Frequency - If the patient has problems following the LEDs, the alternation frequency can be 

slowed.   

 

Auto Save Sweeps – The raw data of every sweep can be saved to file. The files will be saved 

under C:\EMWIN\EOGData. The sweeps will be saved as sweep_001.txt and so on up to 

sweep_999.txt 

 

The settings in EOG recording time are preset to the ISCEV standard and usually do not need to 

be changed. However if the patient has reached the lower value in the dark adapt time, the time 

may be shortened while the test is being run. If the patient has reached the peak in the light-adapt 

phase, the test can be stopped; all information needed has been recorded.  

 

The EOG backgrounds are set to low for Pre-adapt and Medium for Light-adapt. According to 

ISCEV standard the eyes of the patient must be dilated for EOG, so it is not recommended to use 

the high intensity background on dilated eyes. 

  

Display Scale - If the data seems too large for the window, change the display scale to a lower 

setting.  

 

Custom Intensity Background Light - for UTAS SunBurst and 

BigShot user, the light adapt phase can be set to a custom intensity; 

just select Custom in the Light Adapt drop down list and type in the 

desired value.  

 

 

10.6.2 Analyze 

 

Once waveforms are displayed, many analysis features 

can be implemented.   For each function, the system 

will ask which waveforms are to be acted on.  

 

 

 

 

 

 

 

 

Smooth – 

Smoothing can be achieved by going to Analyze -> Smooth or by clicking on the 

following icon.  

 

The smoothing algorithm is useful for removing excess high frequency noise from a waveform.  

The smoothing procedure consists of replacing each point in the waveform by the average of the 

surrounding 11 points (five on each side plus the point itself).  This process acts as a high-cut 

filter that preserves the latency of all of the features of the waveform.  If smoothing the 
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waveform once does not provide sufficient noise reduction, the smoothing operation can be 

performed multiple times.  

  

Warning: Smoothing a single flash ERG waveform will remove any 

oscillatory potentials and may change the initial slope of the a-wave. 

 

Baseline Correct 

Baseline Correct can be achieved by going to Analyze -> Baseline Correct or by clicking          

on the icon.  

 

The purpose of baseline correction is to remove any slope or ultra-low frequency noise from the 

data that might interfere with estimating amplitudes.  Baseline correction is accomplished by 

performing a linear regression on the data and subtracting the resulting line from the waveform.  

If the stimulus is flickering, the slope of the line is estimated from the entire waveform; 

otherwise it is estimated from the pre-stimulus baseline.   Thus, if a waveform has an overall 

upward slope, baseline correction will remove it.  If the waveform goes first up and then down 

(or vice-versa), the baseline correction function may not be useful. 

 

Invert 
Invert can be achieved by going to Analyze -> Invert or by clicking on the icon. 

 

A waveform may be inverted (make positive-going potentials appear below baseline and 

negative-going potentials appear above baseline).  This feature is useful if you wish to make the 

waveform appear as if you had interchanged the + and - connections to the patient amplifiers.  It 

is also useful for subtracting waveforms. (See Add Waveforms) 

 

Add Waveforms  
Add Waveforms can be achieved by going to Analyze -> Add Waveforms or by clicking on 

the icon. 

 
Two or more waveforms may be added together by selecting Add Waveforms.  All of the 

waveforms chosen will be added together and will replace waveform 1 on the screen.  (The 

original waveforms will be removed, leaving only the summed waveform.)  
 

Two waveforms can be subtracted by first inverting one of them (see Inverting Waveforms 

above) and then adding the two together.  For example, it is possible to subtract a Scotopic Red 

ERG from a matched Scotopic Blue ERG to remove the cone contribution and obtain a good 

estimate of the isolated rod ERG. 

 

Off-Line Average  

Off-Line Average can be achieved by going to Analyze -> Off-Line Average or by 

clicking on the icon. 

 

It is possible to retrieve and average waveforms that have previously been stored to disk.  This 

process is called off-line averaging.  First, open all of the waveforms to be averaged, placing all 

of them on the screen at one time.  Then select Off-Line Average.  All of the waveforms chosen 
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will be averaged together and will replace waveform 1 on the screen.  (The original waveforms 

will be removed, leaving only the averaged waveform.)  

 

Remove Interference - Sometimes, despite all precautions, a recording will contain some power 

line interference.  If desired, EMWin will estimate the amount of power line interference in the 

waveform and remove it.  Of course, after the waveform is stored, there’s no way to know how 

much of the signal at the power line frequency (60 or 50 Hz) is noise and how much is part of the 

original signal, so EMWin subtracts all of it out.  Except for 30 Hz flicker (where there may be a 

substantial real component at 60 Hz), this subtraction should cause no problems. 

 

Removing power line interference after the test has been performed can clean up a waveform 

that has some noise in it, but it will not rescue an otherwise uninterpretable waveform.  If the 

power line interference is larger than the original signal, the waveform should be discarded. 

 

Analyze Oscillatory Potentials 

 

Analyze Oscillatory Potentials can be performed from Analyze -> Oscillatory potentials 

or by clicking on the icon. 

 

Oscillatory potentials (OPs) are fast wavelets on the ascending edge of the b-wave of the flash 

ERG.  They have been shown to be a good predictor of progression of neovascularization in 

patients with diabetic retinopathy or with central retinal vein occlusion (CRVO). There are two 

methods to obtain OPs from the EMWin system.   

 

The first method that can be used to extract OPs (and the one that LKC recommends) is to record 

the flash ERG with the low-cut filter set normally, and use the software filtering system to 

extract the OPs.  The software filtering method results in a more accurate representation of both 

the amplitude and latency of the individual OP wavelets.   

 

To use the EMWin software to determine oscillatory potentials, record the OPs using the either 

the Standard or the Bright Flash ERG protocol (The Standard protocol follows the ISCEV 

guidelines for recording oscillatory potentials, while the Bright Flash protocol more closely 

approximates the technique of Bresnick et al.).  Store the raw waveforms.  Click on Analyze and 

select Analyze Oscillatory Potentials.  After the waveforms from which to extract Ops have been 

chosen, EMWin will filter the waveforms and display them on the screen. The waveforms may 

then be stored again.  

 

After the waveforms have been filtered to extract OPs, EMWin will ask if to automatically place 

cursors on the OP wavelets.  If this is desired, click Yes.  The program will then place cursors on 

the oscillatory potentials (at its best guess for the maximum and minimum for each one) and will 

determine the summed OP amplitude.  EMWin will place up to 10 cursors on up to 5 OP 

wavelets. To access the cursors of these wavelets, use the Cursors option from the Reports 

Menu.  The summed OP amplitude will be reported at the top of each analyzed waveform. 

 

The second method is to record the flash ERG with the low cut filter of the patient amplifiers set 

to 75 Hz.  The 75 Hz filter will remove the low-frequency components of the ERG, leaving only 



UTAS Software 

 
 

Version 2.4 56 

the higher frequency components, including the oscillatory potentials.  (Step 3 of the Standard 

ERG Protocol implements this filtering.) 

 

The cursors may also be manually placed on the Ops by selected Cursors from the Reports tab or 

the button bar.  

 

Flicker Amplitude and Timing  

Flicker Amplitude and Timing can be performed from Analyze -> Flicker Amplitude and 

Timing or by clicking on the following icon. 

 

EMWin provides a means of determining the implicit time and amplitude of the flicker 

electroretinogram.  This technique only works for flicker rates of 20 Hz or faster.  The implicit 

time estimates are derived somewhat differently from the normal technique of placing the cursor 

at the peak of the response.  The technique used by EMWin estimates implicit time based on 

finding the center of the response; this technique has been proven effective in prediction of 

neovascularization of the iris in central retinal vein occlusion. (CRVO) 

 

To automatically determine implicit time and amplitude of a flicker ERG, click on Analyze and 

select Flicker Amplitude and Timing.  Select each waveform to analyze.  The analysis will then 

be performed.   

 

After the analysis is complete, the estimates of Amplitude and Implicit Time (abbreviated Ampl. 

on the screen) will be displayed.  This technique does not affect the placement of cursors on the 

waveform, nor does it place any cursors of its own.   

 

Retinal Ischemia Monitor  

This can be found under Analyze -> Retina Ischemia Monitor 

The Retina Ischemia Monitor (RIM) algorithm developed under a grant from the National 

Institutes of Health, analyzes 30 Hz flicker ERG waveforms to provide information about the 

extent of ischemia (inadequate blood supply) in the retina. Implicit time provides more 

information than amplitude. The implicit time reported by Retinal Ischemia Monitor is not the 

same as the implicit time of the peak of the waveform.  

 

Fast Fourier Transform 

Fast Fourier Transform can be performed from Analyze -> Fast Fourier Transform or by 

clicking on the following icon. 

 

The Fast Fourier Transform is computed for selected waveforms, giving information on specific 

frequency components of waveform data.  It is possible to determine the amplitude and phase of 

a specific component using the mouse. 

 

10.6.3 Undo 

 

This will remove all the analysis that was performed on the waveforms prior to saving (smooth, 

analyze OP, auto scale….) 
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10.6.4 Graph Properties 

 

These options control how the data is displayed on the graph. 

 

Show Normal - This function will write the upper and lower 

normal limits of the standard ERG adjusted to the age of the 

current patient. This function is toggled on/off to add/remove 

the normal data from the waveforms. LKC only provides 

normal values for the standard 5 step ERG protocol.  

 

Auto Scale - This will expand all waveforms to fit closely within the waveform’s axes. Although 

the Auto Scale feature make waveforms look larger in amplitude, these large amplitudes can be 

deceiving, since even small-amplitude signals will be expanded to fit the entire graph.  Please 

use this feature with caution when analyzing waveforms. 

 

Line Thickness - This option allows the user to choose from among Thin, Thick, and Extra Thick 

for the thickness of the line.  The default is Thin.  Thicker lines may be useful for easier 

visualization, especially on printouts and faxes. 

 

Data Layout - This allows the data to be displayed as separate data sets or overlapping data sets. 

 

Setup Normal Data - This allows practice-specific normal data to be entered for the standard 5 

step ERG protocol so that it displays when “show normal” is selected. It is recommended that 

each institute develop their own normal data. Normal data differs for each electrodes type (ERG-

Jet, Burian Allen…) particularly in amplitudes.  Only use this feature for 5 step ERG protocols.   
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Show Flicker Labels - Choose whether the data displayed as separate data sets or overlapping 

data sets. This is a check ON/OFF options. It is set as always ON; hence each flash will be 

represented by an upside down triangle on the flicker waveform.  

 

10.6.5 Retrieve 

Search -This option returns the screen back to the Patient Information Screen and allows a new 

search to be performed.  

Next - Selecting Next will display the next waveform(s) stored in the current database.   

Previous - Selecting Previous will display the previous waveform(s) stored in the current 

database.   

Re-Read - Clicking on Re-Read will redisplay the current waveform.  This is especially useful 

when analyzing data and the original, unedited data is needed. 

Add More - Clicking on Add More will open the search waveform window and allow adding 

more waveforms to the report.  
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10.6.6 Record 

This will open a window streaming the real time data: baseline.  

 

Running the baseline is the first action to do when starting a test. Once this button is 

clicked, real time acquisition of data is observed. A good baseline be reasonably flat and should 

not have 50/60 Hz cycle noise.   

 

Baseline – starts streaming real time data, click stop to stop the baseline recording.  

 

Record – From the baseline menu it is possible to start recording immediately by clicking on 

Record Data  

 

 
 

Impedance Test (ONLY AVAILABLE ON EPIC-4000 and UTAS-3000 SYSTEMS) – allows the 

impedance of the electrode to be tested. This is useful once the electrodes are placed on the 

patient. The lower the measured impedance is the better the electrode-patient contact, which 

relates to a better recording. If there is a high impedance value (higher than 40 kΩ), consider 

reapplying the electrodes, adding more gel or cream, or cleaning the skin as appropriate. 
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10.6.7 Store 

This stores the waveforms in the currently selected database. Choose to save all displayed 

waveforms or select the one to be saved. The waveforms are saved back to back and 

given a number. The latest saved waveforms will be the waveform with the highest waveforms 

number in the database.  

 

10.6.8 Step 

 

To proceed to another step in the protocol, click on step. Select 

Step Forward to proceed to the next step in the protocol, or select 

Step Backward to proceed to the previous step. The appropriate 

stimulus conditions and step number for the step will appear at the 

bottom of the screen.  

 

There are several ways to move forward and backward. Use either 

the big arrow icons, pointing left to move backward pointing right to move forward or by 

clicking on Step then Forward or Backward or Step To to jump to any of the steps in the 

protocol. Finally, it is possible to use the keyboard F3 to go backward and F4 to go forward. 

 

 

 

 

 

The text at the bottom of the screen indicates if the current waveforms have been stored. 

 

10.6.9 Place Cursors 

 

In order to measure the amplitude and time of specific locations of waveforms, use the 

Place Cursors feature.  It is possible to place up to 10 cursors on each waveform, 

although only two or four cursors for a single response are typical.   

 

 

   

 A new box (picture above) will be shown at the bottom of the screen, which indicates that 

the cursors will be placed on Waveform 1.  Also, notice that a set of cross hairs is placed 

on the first (top) waveform on the screen.   

 

 Left-Click on the waveform on which you want to place cursors on.  

 

  EMWIN will automatically select Cursor 1 to start with, which indicates that cursor 1 is 

the cursor to be placed on the waveform. 



UTAS Software 

 
 

Version 2.4 61 

 

 Use the Left Arrow () and Right Arrow () keys to slowly scroll through a 

waveform.  As the cross-hair moves, the amplitude and time data will automatically 

update.  Hover the mouse arrow over the point to place the cursor and left click on the 

mouse, this will also place the cursors.  

 

 To move through a waveform faster, use the Page Up and Page Down keys. 

 

 When the cross-hair is located at the data point of your choice, press the Enter key.  This 

will place a marker on that waveform.  Use the Place Cursor button at the bottom of the 

screen. 

 

 After Enter is pressed, notice that the selected option is now 2, since EMWin assumes 

the cursors will be placed in sequential order. 

 

 

10.6.10 Print 

 

The currently displayed waveforms can be printed to any standard Windows printer.  After 

clicking Print (from either the menu option or the toolbar button), a Print Preview of your data 

will appear, showing how the data will appear when printed.  Words that may appear jumbled on 

the preview screen will be expanded to appear normal on the printout. Double-click the image to 

zoom in or double-click the right mouse button to zoom out. To print the data, click on the Print 

button. 

 

The first page will have the patient name, their birthdate, the waveform pictures, and the first few 

cursors for each waveform. It also shows amplifier settings, number of average waveforms and 

other stimulus information. If many cursors have been placed they will show on the second page 

named Waveform Details. The third page contains all the patient information, comments entered 

and all analysis routines that have been performed on each waveform. 

 

The user also has the option of printing the report to a pdf format. After clicking the Print (from 

the menu option or toolbar button), the same Print Preview appears. Click on the Print button at 

the bottom of the screen after the pages desired have been selected. Another window will appear, 

where the printer to be used can be selected. The program CutePDFWriter has been preinstalled 

on the computer and should be used to save the report as a pdf. Select the CutePDFWriter as the 

printer in the scroll down menu, and press print. Instead of printing, a save as box will appear 

where the destination and name of the report can be entered.  
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Note: 

If printing data from two different patients on the same printout, the patient 

information at the top of the printout (name, date of birth, etc.) corresponds to the 

data from the first waveform only. 

 

If printing with the purpose of faxing the waveforms, the lines will need to be 

thickened (see section 10.4.4). Graph Properties -> Line Thickness -> Thick 

 

 

10.6.11 Update Patient Information 

This allows the user to change the patient information or enter comments during 

recording. The changes need to be made before the waveform is saved to the database.  

 

 

10.6.12 Change Eye 

This icon allows the user to view the number of channels that are being used at that time. 

From this window, the labels for the channels (automatically filled in as R in channel one 

and L in channel two) can be changed.  
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10.6.13 Measure Interference 

The measure interference button collects one sweep of data from each channel and 

determines the amount of main interference (50 Hz or 60 Hz, depending on 

configuration); measured in µV. (Higher numbers are worse.) The information will 

dictate whether a good recording from the patient can be obtained. Excessive interference 

is often caused by poor electrode contact, so if the interference value is high, check the 

electrode contact and re-measure.  

 

 

10.6.14 Red Background Light 

This will turn the background light of the Ganzfeld on red as well. This is meant to help 

assist the technician when placing the electrodes without ruining dark adaptation of the 

patient.  

 

 

 

 

10.7 Creating Reports 

 

10.7.1 Selecting Patient’s Data 

 

The first step in generating a report is to select the waveforms that will be displayed.   

From the main menu, go to Create Report. EMWin will put up a Patient Information Screen to 

fill in and search through the waveforms with. The more filled in, the fewer waveforms that must 

be searched through to find the desired ones.  

 

In the Action window, View Waves is selected as default, allowing the waveforms to be 

displayed in order to create the reports. Export Waves and Export Cursors will be discussed in 

the export data section 10.10.1. 
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    Patient Information Screen 

 

In many cases, filling in the patient’s last name will be sufficient to search through the large 

database.   

 

Filling in the Age Range as 45 - 55 would select all patients aged 45 to 55.  Note that this 

computes the age of the patient at testing, not the present age of the patient.   

 

Filling in Test Date as 11/1/1990 - 11/30/1990 would select all tests performed in November, 

1990. 
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Any menu item which is left blank is assumed to match all items.  As an example, to find the 

ERGs of all patients named Smith who were tested in July of 1990, fill out the menu as follows: 

 

 

 Last Name   :  Smith 

 First Name   : 

 Middle Initial   : 

 Identification   : 

 Sex    : 

 Birthdate   : 

 Age Range   : 

 Test Date    :  7/1/1990 - 7/31/1990 

 Other    : 

 Test Type   :  ERG 

 Record Number: 

 Start Number   : 

 Diagnosis   : 

 

If EMWin reports No Matches Were Found, either the name was either misspelled in the search 

or the patient name may have been mistyped when the test was performed.  It is also possible 

that the waveform is stored in a different database or has been deleted.  Use wildcards (*) to help 

reduce errors.  For example, the search term: Sm* will find "Smith", "Small", "Smythe," etc. 

 

EMWin will search through all of the waveforms and display on the screen all of those that 

match the items filled in on the menu.  Select the waveforms to display by clicking anywhere on 

the line of the appropriate waveform.  If a mistake is made, click on the box again to deselect it.   

 

Notice the list of waveforms in the “Search Results” box.  The waveforms that selected will be 

displayed on the next screen.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



UTAS Software 

 
 

Version 2.4 66 

10.7.2 Selecting the Display View 

Once the search parameters have been entered, the search result box will appear as follows: 

 

 
 

 

It has two main windows that contained the data waveforms. Left-hand Graph refers to the left 

half page of the report; Right-Hand Graph refers to the right half page of the report.  
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There are two different ways to display the data: 

Option 1: Select waveform 2 (in this case L eye ERG) in Left-hand Graph and waveform 

1 (in this case R eye ERG) in Right-hand Graph then the data will display as below. 

  

 

 

 

 
Option 1 
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Option 2: If the two waves are selected in the Left hand Graph window then they will 

appear on top of each other in the report. 

 

 

 
Option 2 

 

 

 

 

 

 

Both options have advantages and inconveniences.  

 

In option 1, up to 5 waveforms can be selected on each side, however only the first 4 cursors will 

be displayed on that first page. All additional cursors will print out on the second page. Also the 

waveforms will appear a lot smaller since it is only using half of the page.  
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In option 2, the waveforms are more visible because they are using the whole width; all of the 

cursors will display on that first page (no need to print an extra page); however, there is a 

maximum of 5 waveforms that can be displayed with this option.   

 

10.7.3 Adjusting the Data Display 

 

There are several things that can be done to adjust the display of the data on the reports. Along 

the right and left time axis, the waves can be zoomed in on. (see example below)  

 

To adjust the time scales (for display purposes only) first click on the waveforms and then move 

the Xmin and Xmax tabs to the desired location.  

 

The gain buttons allows the user to zoom in and out in amplitude. To change the amplitude of 

one curve and have the second one match:  
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Select one of the waveforms, adjust the gain and click on the  icon. This will set all 

waveforms currently on display to the same amplitude scale.  

 

The position buttons allows the user to move the waveforms up and down on the displays.  

 

10.7.4 Retrieving data 

 

Once the first report is done, use the retrieve menu to select the next waveform to avoid going 

back to the main menu. See section 10.6.5 about the retrieve menu.  

 

 

10.8 User-Defined Protocols (UDP) 

 

10.8.1 Creating user-defined protocols  

 

To write a User-Defined Protocol, 

choose Design Protocols and choose 

Design from the Main Menu.  The 

option of writing a new protocol, 

editing an existing User-Defined 

Protocol, deleting a protocol, or 

printing out a summary of a protocol 

will appear.   

 

To create a new protocol, click on 

CREATE NEW PROTOCOL. To 

create a new protocol that closely 

resembles one already existing, click 

the protocol you want to clone and 

choose CREATE PROTOCOL 

FROM. This will copy all the 

information from the selected 

protocol and with the opportunity to 

make changes to it.  

 

 

 

If creating a new protocol, then the screen below will appear. This screen is used to enter the 

Protocol Name, Test Type, and Stimulator Type.   

 

The Protocol Name must be unique or the system will be ask to replace the existing file.  At this 

time, ERG and VEP are the only available options for Test Type.  Only the stimulators that the 

equipment is configured for will be offered as choices under Stimulator Type.  The other 

stimulators will be grayed out. Depending on which stimulator is used, the appropriate parameter 

window will open. See section 10.6.1 on parameters. Be sure to check all 4 tabs and select the 

values desired (stimulator parameter, amplifiers, timeframe and averaging).  
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Note: All flicker stimuli should have a pre-stimulus baseline of 0 in the timeframe 

tab 

 

Once all the tabs for the first step of your protocol are checked, click continue, and the choice to 

add another step or finish the protocol (which would create a one-step protocol) will come up. If 

add another step is selected, the software will automatically use the values selected in the 

previous as default.  

 

10.8.2 Editing user-defined protocols  

 

UDPs can edit any user defined protocols by going 

to Design Protocol -> Design selecting the 

protocol to be edited and clicking on Edit.  

 

The choices given are to add, edit, insert or delete 

steps.  

 

 

 

 

 

 

 

 

 

 

 

10.8.3 Using user-defined protocols 

 

To use the UDP that has been created, go to Perform Test -> User Defined Protocols and select 

that protocol from the list.  

 

  
 

 

 

 

10.8.4 Changing Standard Protocols 

 

EMWIN comes with a preset number of ISCEV standard protocols such as On/Off, standard, 

double flash, etc. It is possible to change those protocols to fit the specific clinic’s needs using 

the methods described above.  
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The standard protocols are stored in C:\EMWIN and have .PRO extensions. See appendix 3 for 

the list of all standard protocols, their names and parameters. If the settings of a standard 

protocol are changed, the extension of the protocol file must also be changed from .UDP to 

.PRO. The protocols will then be able to be edited as described in section 10.8.2. Once done 

editing the protocol, don’t forget to change the extension name back to .PRO 

 

10.8.5 Printing Standard and User Defined protocols 

 

To print protocols go to Design Protocol -> Print. A list of protocols will appear. The files with 

.UDP extensions are the user defined protocol, the .PRO are the standard protocols. All the 

UTAS protocols have a capital U as the last letter of their name such as stdergU.pro for the 

standard ERG. 

 

 

10.9 SunBurstSunBurst / BigShot Error Sounds 

 

SunBurstSunBurst and BigShot have a built in speaker. It will play music when it is first turned 

on. There are some occasions where the Ganzfeld might emit sounds.  

 

Ganzfeld Sounds and Meanings: 

1. Ganzfeld is playing the Jeopardy theme song “Think”. This means the Ganzfeld is 

overheating. SunBurstSunBurst will keep playing the music and not respond to any 

other commands until the temperature goes down enough.  

2. Single Beep. This indicates a wrong command was sent to the Ganzfeld.  

3. Two Beeps. The two beep scheme is used to signal that the flash or background light 

that is commanded is either out of the possible color or luminance range.  

 

Short Beep of Medium Frequency followed by Short Beep of Higher 

Frequency: Color out of bound 

 

 

Long Beep of Medium Frequency followed by Short Beep of Lower 

Frequency: Luminance out of allowed range 
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10.10 Other Features 

 

10.10.1 Exporting Images 

 

Exporting the patient data for analysis or visualization in other programs 

is very simple.  When a graph of data is on the screen (either in Test 

Mode or Report Mode), click anywhere on the white background of the 

graph (left side or right side) with the right-mouse button.  A pop-up 

menu will appear with a list of features.  Select the item labeled “Export 

Dialog” and the Exporting Electroretinogram window will appear.  

 

The picture can be exported in Metafile or Bitmap format to the 

Clipboard, a specific file of the user’s discretion, or the printer.  

 

10.10.2 Batch Exporting 

Waveform Data and Cursors 

 

EMWIN has the capability to export 

up to 1000 waveform and cursors of 

1000 waveforms into a .CSV file 

format.   

 

In order to export the waveforms, 

Cursor, and patient information into 

this type of file, go to Report and 

select Export Waves in the Action 

window.  
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Then click on Continue, this will bring up the list of all waveforms.  
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Use the Ctrl or Shift key to select multiple waveforms to export. The default name of the export 

file is Export.CVS. If needed, the name can be changed by typing the desired new name in the 

Export File Name window.  

Once Continue is clicked, the export file will be created and saved under C:\EMWIN\Export. 

 

Note: if multi-data (created a protocol where in one step the software will automatically collect 

more than 1 waveform and save all individual waveforms) are recorded, all the waveforms will 

be exported back to back; however, only the cursors on the first waveform will be exported.  

 

10.10.3 Importing Data From Your DOS LKC System 

 

Previous users of any version of EM for DOS software may also convert older data to the 

EMWin format.  This allows the user to exploit the powerful report making features that are not 

available in previous versions of LKC software. 

 

In the "EMWin" folder of the hard drive of the computer (c: drive), there is a program named 

"CONVERT.EXE".  Double-click this icon with the left-mouse button to open this conversion 

utility.  Data from all versions of EM for DOS are named "WAVEFORM.xxx", where xxx is a 

number from 001 to 999.  Select the disk drive that contains these waveform files.  Typically, 

these files would be copied from an older EPIC or UTAS system to a floppy or zip disk (if files 

are stored on floppy disks, please contact LKC to purchase a floppy disk to USB adapter). Now, 

select the appropriate directory and sub-directory to copy them to. 

 

Before converting the data, you must first determine the target database for the waveforms.  The 

default option for the "Convert" program is the currently selected database for EMWin, which is 

displayed at the bottom right of the menu.  Waves will be added to the end of this database in 

chronological order.  From this menu, a different database can be selected or a new one created 

for this data.   

 

For example, to create a new blank database for all EM for DOS data: 

 

1.  Click the "Create New Database" 

2.  In the text box, type "EMDOSDATA" (or any other name) and click "OK." 

3.  Now click the "Select Database" button, and choose "EMDOSDATA" from the list. 

4.  Click "Continue". 

 

At this point, all converted data will be added to the new EMDOSDATA database. 

 

On the right side of the Conversion utility screen, multiple waveforms can be selected using the 

<Shift> and <Ctrl> keys.  Holding down the <Shift> key allows a range of waveforms to be 

selected at once.  Holding the down the <Ctrl> key allows individual waves to be selected.  Once 

all desired waveforms are selected, click the "Go" button.  After it has completed (this may take 

a few seconds), a message will appear indicating a successful conversion.  
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TESTING THE PATIENT 

11.0 Introduction 

This portion of the User's Manual contains instructions for testing patients with LKC's UTAS 

system. The manuals for hardware and software components of the system should already be 

understood. This section will focus only on how to use the instrument to test patients 

 

 

12.0 The Electroretinogram (ERG) 

 

12.1 Overview 

 

The electroretinogram (ERG) exposes the patient to some visual stimuli and measures the 

electrical response of the retina. The most commonly used stimuli are a flash of light (either 

bright or dim) or an alternating pattern of light flashes. 

In clinical testing, the electrical response of the retina is measured by placing one electrode on 

the cornea and a second electrode on a reference location, usually the forehead, and measuring the 

electrical difference between the two. This difference is measured by a sensitive amplification 

system which can detect millionths of a Volt (called microvolt, and abbreviated as µV). In 

contrast, a typical wall outlet produces more than 100 Volts, more than a million times greater 

than the typical ERG signal. 

Typically, ERGs are performed with a flash of light that covers the entire retina. To ensure that 

this happens, a device called a Ganzfeld is used. A Ganzfeld is a device that resembles a bowl 

covering the patient’s vision field and is coated with highly reflective paint. The flash of light 

stimulus evenly illuminates the interior of the Ganzfeld and allows the most penetration of light 

into the patient’s eye. 

The flash ERG can be used to separately measure the response of the retinal rods and cones. The 

response of the rods is measured by first dark adapting the patient and then stimulating the eye 

with dim flashes of light. Using a bright flash of light tests both the rod and cone response. The 

rod function is suppressed when the patient's eyes are exposed to an adapting light so that only 

the response of the cones is measured. Rapidly flickering lights is also used to measure cone 

function. The most commonly used flash ERG test is the "standard ERG" which encompasses all 

of the above tests. 

Other types of ERGs include the multifocal ERG (measures the function of the macula) and the 

pattern ERG (measures the function of the inner retinal layers, including the ganglion cells). The 

Standard ERG is the most commonly used, so we will focus on it for most of the section while 

also mentioning some of the other types.  
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12.2 ERG protocols 

 

If the system contains a mini Ganzfeld with the SunBurstSunBurst or BigShot, some of the 

protocols will be the same; such as the Standard and Standard with Mini-Ganzfeld protocols. 

The only difference is the instrument used to deliver the stimuli and the fact that with the mini-

Ganzfeld unit, it is possible to only test one eye at a time.  

 

12.2.1 Standard ERG Protocol 

 

This protocol currently recommended by the International Society for the Clinical 

Electrophysiology of Vision
1
 (ISCEV); they explain: 

 

In 1989 a basic protocol was standardized so that ERGs could be 

recorded comparably throughout the world. This standard was 

updated most recently in 2008. Standards for five commonly 

obtained ERGs were presented: (1) ERG to a weak flash (arising 

from the rods) in the dark-adapted eye (2) ERG to a strong flash in 

the dark-adapted eye (3) Oscillatory potentials (4) ERG to a strong 

flash (arising from the cones) in the light-adapted eye (5) ERGs to 

a rapidly repeated stimulus (flicker)  

 

The rod response is particularly useful to determine hereditary night-blinding disorders as well 

as conditions that involve peripheral retinal function, such as diffuse inflammatory disease.  The 

cone response is used to diagnose cone dysfunction in hereditary or acquired disease.  Flicker 

responses document ERG timing that can help diagnose vascular disease or discriminate between 

dystrophies and acquired degenerations.  The maximal response provides an overall indication of 

the retina function, and can be used to diagnose conditions such as traumatic retinal damage or 

evaluate visual impairment in infants.  The oscillatory potentials are used to determine disorders 

that cause retinal ischemia, such as diabetic retinopathy. 

 

 ERG Conditions - Standard Protocol: 

 
 
1 

 
Scotopic 

 
Single Flash 

 
-24 dB 

 
Rod Response 

 
2 

 
Scotopic 

 
Single Flash 

 
0 dB 

 
Maximal Response 

 
3 

 
Scotopic 

 
Single Flash 

 
0 dB 

 
Oscillatory Potentials 

 
4 

 
Photopic 

 
Single Flash 

 
0 dB 

 
Cone Response 

 
5 

 
Photopic 

 
30 Hz Flicker 

 
0 dB 

 
Flicker Response 

 

                                                 
1 International Standardization Committee.  Standard for clinical electroretinography (2008 update).  Documenta 

Ophthalmologica 118: 69-77, 2009. 
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Unless specified otherwise in the protocol, 10 sweeps will be averaged for 30 Hz flicker 

(stimulus condition 5). 

 

20 minutes of dark adaptation is required in the 

Standard Protocol prior to any stimulation 

 

 

12.2.2 Extended ERG Protocol 

 

In the 2008 update of the ISCEV Standard for full-field clinical electroretinography, it is 

recommended that an additional flash is performed while the patient is dark adapted. This flash 

stimulus is called the Dark-adapted 10.0 ERG and occurs after the standard step 3 in the protocol 

at an intensity of 6dB.  The purpose of the additional gives is to produce a response with a larger, 

more defined a-wave and identifiable oscillatory potentials. The more intense stimulus can also 

be useful for eliciting a maximal response from patients with denser opacities who would 

normally not be able to produce the response to step 2.  

 

 ERG Conditions – Extended Protocol  

 

1 Scotopic Single Flash -24 dB Rod Response 

2 Scotopic Single Flash 1 dB 
Maximal 

Response 

3 Scotopic Single Flash 1 dB 
Oscillatory 

Potentials 

4 Scotopic Single Flash 6 dB 
Larger a-wave 

Response 

5 Photopic Single Flash 1 dB Cone Response 

6 Photopic 30 Hz Flicker 1 dB Flicker Response 

 

 

12.2.3 Classic ERG Protocol 

 

Until the adoption of the Standard Protocol by ISCEV, the Classic Protocol was the most 

commonly utilized ERG diagnostic protocol. It also consists of 5 steps, as follows. (1) The 

Scotopic Blue stimulus. Since rods are more sensitive to short wavelength light (blue), this step 

isolates the rod response. (2) The Scotopic Red stimulus, displays both the rod and cone response 

on a single waveform. Interpretation of this waveform may be difficult. (3) The Scotopic White 

stimulus provides a maximal response of both the rod and cone systems. This is the same 

stimulus as step 2 of the Standard Protocol. (4) The Photopic White stimulus is designed to 

suppress rod participation. This is the same stimulus as condition 4 of the Standard Protocol. (5) 

The 30 Hz Flicker stimulus isolates the cone response because the flicker is too fast for the rods 

to follow. This stimulus is done without background light. 

ERG Conditions - Classic Protocol 
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1 Scotopic Single Flash Blue - 38 dB Rod Response 

2 Scotopic Single Flash Red +8 dB Rod+Cone Resp. 

3 Scotopic Single Flash 0 dB Maximal Response 

4 Photopic Single Flash 0 dB Cone Response 

5 Photopic 30 Hz Flicker 0 dB Flicker Response  

Unless specified otherwise in the protocol, 10 sweeps will be averaged for 30 Hz flicker 

(stimulus condition 5). 

30 minutes of dark adaptation are required in the 

Classic Protocol. 

 

12.2.4 Bright Flash ERG Protocol 

 

The Bright Flash protocol presents a stimulus that is much brighter than the intensity of the 

standard flash. It is normally used for subjects with sufficiently dense media over the eye that the 

standard flash cannot elicit a response from. The Bright Flash protocol should not be used to 

attempt to elicit a larger response from subjects with relatively normal media (unless attempting 

to determine the asymptotic PI, amplitude, or measure the photoreceptor kinetics). The Bright 

Flash Protocol may also be used to elicit oscillatory potentials. If the Bright Flash receives 

maximum amplitude Ops, use a conditioning flash followed by the recording flash 30 seconds 

later. 

 

When testing a subject with one relatively normal eye and one with opaque media, the normal, 

dilated, eye should be patched to prevent severe discomfort from the bright flash stimulus.  

 

12.2.5 Photopic Negative ERG Protocol 

 

The photopic negative response (PhNR), originating from the inner retina, appears after the b-

wave (and if the flash duration is long enough, it appears again after the d-wave). The PhNR 

arises as a consequence of the spiking activity of the retinal ganglion cells. PhNR may be a 

sensitive measure of retinal dysfunction in patients with diseases that affect the inner retina such 

as glaucomatous damage.  

 

The photopic negative response is elicited using a 200 ms red (630 nm) stimulus with a blue 

background (470 nm). 
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12.2.6 S-Cone ERG Protocol 

 

S-Cone ERGs facilitate the determination of enhanced S-cone syndrome, a rare disorder related 

to mutation in NR2E3. By enabling a more detailed assessment of the relative involvement of S-

cones in other genetically determined disorders, they contribute to a more accurate description of 

the phenotype.  

 

S-Cone recording requires a bright photopic background to suppress the rod and L-cone and M-

cone function. The typical protocol uses a blue flash (470 nm) on a bright amber (590 nm) 

background.  

 

 
 

12.2.7 On/Off Response 
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The L- and M- cones cells signal via both ON- (depolarizing) and OFF- (hyperpolarizing) 

bipolar cell pathways. Rods do not communicate with OFF- bipolar cells, and no S-Cones OFF 

bipolar cell have been identified. Long duration stimulation enables the functional separation of 

the cone ON- and OFF- responses.  

 

ON- and OFF- response recording enables an assessment of the post-phototransduction cone 

pathways. This may reveal abnormalities not usually indicated by a more conventional cone 

ERG protocol and may therefore contribute to an accurate determination of the site and nature of 

the cone system dysfunction. This knowledge may help in the management of both inherited and 

acquired retinal disease.  

 

 
 

 

 

12.2.8 Flicker ERG Protocol 

 

The flicker ERG protocol is one that measures cone response by presenting a flickering stimulus 

that is too fast for rods to respond to.    The protocol presents flickering stimuli at 5, 10, 15, 20, 

25, 30, 35, and 40 Hz.  It is used mostly in research investigations. 

 

12.2.9 Pattern ERG Protocol 

 

 This protocol uses an alternating checkerboard pattern to elicit a retinal stimulus, unlike the 

flashing light stimuli in other protocols.  Because equal amounts of the retina are stimulated as 

the checkerboard alternates, the response is a measure of neuron and ganglion cell activity of the 

inner retina rather than the rod and cone activity.  As such, the pattern ERG is useful in 

diagnosing inner retina disorders. 

 

The pattern ERG is a photopic test, so dilation and dark adaptation are not necessary.  Because 

the edges of the checkerboard are important components of the stimulus, any refractive error 

should be corrected.  If cycloplegic drugs are used, a one diopter plus added should be used to 

compensate for the typical screen distance of one meter. 
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12.2.10 Double Flash ERG Protocol 

 

The double flash protocol is used to study the recovery of photoreceptors. It consists of a bright 

conditioning flash followed by a measurement flash.  The amplitude of the measurement flash as 

a function of time will provide the information needed. The recovery time of the photoreceptors, 

such as between the two flashes, is affected in several retinal disorders including retinitis 

pigmentosa.   
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12.2.11 Retinal Ischemia Monitor (RIM) Protocol 

 

The RIM protocol can be used to asses ischemic retinopathies such as Diabetic Retinopathy, 

Ocular Ischemic Syndrome, Central Retinal Vein Occlusion (CRVO), Branch Vein Occlusion 

(BVO), Central Retinal Artery Occlusion, and Sickle-Cell Retinopathy. RIM has been shown to 

be 92% accurate in predicting the outcome in CRVO and has a strong correlation to the severity 

of Diabetic Retinopathy. 

 

 
 

12.3 Patient Preparation 

 

12.3.1 Standard ERG 

 The first step in the standard ERG is to dilate the patient's eyes with a mydriatic (any medium-

duration cycloplegic, such as Tropicamide, will be sufficient). If the patient is already dilated 
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from ophthalmoscopy, no further dilation is required. It is more comfortable for the patient if a 

few drops of local anesthetic are administered to the eye before the mydriatic dilating drops. 

The next step is to dark adapt the patient. This step is critical to obtaining good results. The 

patient should be dark adapted for at least 20 minutes before the test is administered (dark 

adapting for longer than the 20 minutes will not alter the results, but dark adapting for less than 

20 minutes will create problematic responses). To dark adapt the patient; simply place them in a 

completely darkened room (such as the room in which you will perform the ERG). Another 

method to dark adapt the patient is to securely patch the patient’s eyes so that no light can get 

through and return them to the waiting room.  

After the patient has been dark adapted for at least 20 minutes, they should be brought into the 

testing room. The testing room must be completely dark (a dim red light is acceptable which 

may be provided by the Ganzfeld’s background red LED if needed)  

12.3.2 Pattern ERG  

For the pattern ERG protocol, do NOT dilate the patient’s eyes, as the patient must be able to 

focus on the pattern stimulus (dilation paralyzes the patient’s ability to focus).  The patient 

should not be exposed to bright lights, such as sunlight or a slit lamp, for at least 10 minutes 

before testing. Use the patient’s best lens correction while running the test (with either the 

patient’s glasses or trial lenses).  

12.3.3 MultiFocal ERG  

Dark adaptation is not required for the multifocal ERG protocol because it tests only cone 

function. However, the patient should not be exposed to bright lights, such as sunlight or a slit 

lamp, for at least 10 minutes before testing. 

It is best to perform this test with the eyes dilated; although it doesn't largely affect the test 

results, it will make the technician’s job much easier. To dilate the eyes, apply a cycloplegic 

agent and allow the patient to sit for about 15 minutes for the drug to take effect. If the patient is 

already dilated from a previous procedure, no further dilation is needed.  

This test is only available if you have the multifocal ERG upgrade. 

12.3.4 Other ERGs  

There are several other types of ERGs, such as the intensity-response ERG, the flicker ERG, and 

the bright flash ERG. All of these tests require dilation of the eye and dark adaptation (the 

exception to this is if the eye to be tested is damaged by trauma in which a cycloplegic may be 

contraindicated). After applying dilating drops in the eye, dark adapt the patient for the amount 

of time shown in the table below. 
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Dark Adaptation Period for Various ERG Tests 

ERG Test Dark Adapt Time 

Standard 20 minutes 

Intensity-Response 45 minutes 

Flicker 10 minutes 

Bright Flash 20 minutes 

 

12.4 Electrodes 

 

After the patient has been dilated and dark adapted (if needed), the next step is to attach the 

electrodes to the patient. All ERG tests require two different electrode connections; the corneal 

electrode and the reference/indifferent electrode. Use only electrodes enumerated in Appendix 1. 

Note: If the protocol requires that the patient be dark adapted, the electrodes must be 

applied in the dark room, lit with only a dim red bulb (the Ganzfeld’s dim red 

background light may also be used). 

To apply the electrode, anesthetize the cornea with several drops of a medium duration 

anesthetic, such as proparacaine hydrochloride (do not use a short-duration anesthetic - it will 

wear off before the test is over). While waiting for the anesthetic to take effect, apply the 

electrodes to the locations other than the eye. 

 

12.4.1 The Indifferent/Reference Electrode  

 

The indifferent/reference electrode should be applied first. It is a separate 

electrode, often an ECG (EKG) electrode, such as the Silvon® electrode. The 

Burian-Allen electrode has the indifferent electrode built in (making it a 

bipolar electrode and does not require a separate indifferent electrode).  

The indifferent electrode is applied to the center of the forehead and used as a 

reference for both eyes. With an electrode prep pad, scrub the center of the 

forehead to remove all traces of skin oils and makeup. Let the alcohol dry off 

for a few seconds. Before the indifferent electrode is applied, check it to make sure the center gel 

is still wet (if it has dried out, discard the electrode and get a new one as it won’t be able to 

obtain a sufficient signal from the patient).  

If you are testing two eyes, connect a splitter to the - inputs of recording channels 1 and 2 of the 

UBA-4204. (A splitter is a Y-shaped cable with plugs on two sockets and an arm on the third.) 

Connect the indifferent electrode to the splitter.  

 

12.4.2 The Ground Electrode 

 

The ground electrode, typically a gold cup ear clip electrode, should be 

applied after the indifferent electrode.  
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The electrode is applied to the patient’s ear lobe. With an electrode prep pad, scrub the ear lobe 

to remove all traces of skin oils. Let the alcohol dry off for a few seconds. Fill both cups of the 

ear clip generously with electrode gel and clip it onto the ear lobe. Plug the ground electrode into 

the appropriate ground channel of the amplifier.  

 

12.4.3 The Corneal Electrode 

 

Finally the corneal electrodes should be applied.  The most common corneal electrodes are the 

ERG-Jet electrode and the Burian-Allen electrode (shown below). Other types of electrodes 

include the DTL electrode (also shown below).  

 

 

 

 

 

 

ERG-Jet Electrode                 Burian Allen                           DTL Electrode                         

 

 

 

Contact Lens Electrode 

Before inserting the contact lens electrodes, place several drops of a lubricating solution that 

contains methylcellulose (such as Goniosol or Liquid Tears) in each of the contact lens 

electrodes.  If you are using the ERG-Jet electrodes or the Burian-Allen electrodes, Liquid Tears 

may minimize damage to the cornea. 

 

Gently insert a contact lens into the eye.  Leave a small loop of excess electrode wire (about 1" - 

2" in diameter), and tape it to the patient’s cheek.  Repeat the procedure for the other eye, if 

appropriate. 

 

 

DTL Electrode  

DTL Electrodes are used with patients that cannot tolerate the ERG-Jet contact lens electrode. 

They are single use, silver nylon thread electrodes. They should be placed on the eye so that the 

fiber is running gently across the cornea (not too tight to avoid corneal abrasion).  

 

Gold Foil Electrode  

The gold foil electrode is used to avoid blurring the patient’s vision, where contact lens use is not 

possible (such as in eyes with keratoconus), or where topical anesthetic is not desired.  The gold 

foil electrode has a thin coating of gold deposited onto a Mylar substrate.   

To insert the electrode into the patient’s eye fold the electrode in half lengthwise with the foil 

side out, so that it forms an inverted “V”.  Gently retract the patient’s lower lid and insert the end 

of the electrode into the space between the lower lid and the sclera.  Tape the electrode wire to 

the patient’s cheek to hold the electrode in place. 
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Note that blinking or rapid eye movements easily dislodges the gold foil electrode.  It is 

important that the patient looks straight ahead and does not blink excessively once the electrode 

has been inserted.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

  

  

  

  

  

   Monopolar Electrode Placement (ERG-Jet, DTL...) 

 

 

 

 

 

Always connect the corneal electrodes (active electrode) to the + input of each channel and 

references to the – input of each channel of the UBA-4200. Connect the ground electrode into 

the ground channel.  

 

 



Testing the Patient 
 

Version 2.4 88 

 
                                       Bipolar Contact Lens Electrode Placement 

 

 

12.5 Recording Data 

 

After the electrodes have been inserted, the test may be started. The patient information may 

be inserted into the program before the electrodes are placed on the patient to minimize the 

amount of time the patient must have the electrodes inserted and to speed up the total testing 

time.  

In this section, the Standard ERG protocol will be used. Other protocols are very similar. In 

order to understand this section, familiarity with the UTAS Software manual is necessary.  

 

12.5.1 Setting up the test 

 From the main menu select Tests -> Electroretinogram -> Standard 

 Fill in the patient information (see section 10.5.2 for more info on the patient info 

window) and click on Continue 

 Select the number of channels to be used and label them. Label the channels with the eye 

to be tested. If testing both eyes, select two channels (the convention is to have Channel 1 

labeled as Right Eye and Channel 2 as Left). 
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You are now ready to start the test. Be sure the patient is seated comfortably with their face in 

the Ganzfeld. Instruct the patient to look straight ahead at the red light. 

 

12.5.2 Record – Checking the baseline 

 

Click on Record (which is the first icon of the toolbar). The baseline is a check to make 

sure that everything is working correctly; that the electrodes are connected properly and making 

good contact with the patient, that the patient isn't clenching their face muscles, that no power line 

interference (maybe from the laser next door) is being detected, etc. 

An example of a poor baseline is shown below. This baseline has a large amount of power line 

interference in it. If the baseline looks similar to this one, suspect a bad connection in the system. 

The indifferent electrode may not be making good contact with the forehead or there may be a 

problem with the contact lens electrode. Of course, there are other potential sources of 

interference as well. For more information about interference see Appendix 2: Artifacts in 

Electrophysiology. 

 

Also shown below is an example of a good baseline. Attempt to make the baseline as close to 

this horizontal line as possible. If the baseline does not look good, if it has a lot of vertical lines 

or other noise and occupies most of the screen – it needs to be fix the problem before continuing 

with the test. 

 

 

 
 
 Bad ERG Baseline 
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Good ERG Baseline 

 

12.5.3 Recording Data 

Step 1: Rod Response 

At the bottom of the screen there should be a line reading "Scotopic White 24 dB Single 

Flash".  

Click on Record (this can be found on the top menu or the record Icon). Once the baseline is 

stable, click stop and then click on record. If the response looks good (examples of good 

waveforms are shown in the Analysis section below), click on Store (using the diskette 

icon). If the response does not look good (at this point, usually because of a blink or 

other reflex motion), wait at least two seconds before repeating the flash. 

Note: Always wait at least 2 seconds between dim flashes (if required) of 

step 1 to avoid light adapting the subject. 

After storing a good waveform, move to the next step. Click on the Step Forward icon. 

 

Step 2: Maximal Response 

The bottom of the screen should now read "Scotopic White 0 dB Single Flash".  
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Again, click on Record to measure a baseline and make sure noise hasn’t developed. If the 

baseline looks OK, click Stop and then Record. The response will look different this time - it 

will be larger and less rounded. An example of a good response for the second step in the 

protocol is shown in the Analysis section below. If the response is good, click on Store to save 

the waveforms. If they're not good, wait at least 15 seconds before trying again to avoid light 

adapting the patient. 

After storing a good waveform from step 2, click the Step- Forward icon to proceed to Step 3. 

 

Step 3: Oscillatory Potentials 

The stimulus description at the bottom of the screen won't change for this step since the stimulus 

isn't different for oscillatory potentials, only the recording technique. Again, click on Record to 

make sure no noise has developed. 

To record oscillatory potentials properly: 

 Click on Record. Do not store this waveform. 

 Wait 15 seconds, as counted by the clock at the top right of the screen. 

 Click on Record. If this waveform looks good, store it. If not, wait another seconds and 

repeat the steps. 

The first flash is called a conditioning flash. It is used to sensitize the retina to maximize the 

oscillatory potentials recorded with the second flash, which is measured to give the waveform to 

be stored.  

 

Step 4: Photopic response 

When you click on Step Forward to move to step 4 of the protocol, the background light inside 

the Ganzfeld will turn on. For this step, the patient needs to be light adapted using this 

background light so be sure the patient doesn’t close their eyes for extended periods. The bottom 

of the screen should now read "Photopic White 0 dB Single Flash". 

Wait 10 minutes for light adaptation before recording. 

Repeat the Record, and Store sequence performed above in step 3. 

 

Step 5: Flicker response 

This is the last step of the protocol. The bottom of the screen should read "Photopic White 30 Hz 

Flicker". Click on the Record button. The remainder of this step is automated, so the program 

will automatically start the flash flickering at 30 flashes per second, waiting 5 seconds, then 

averaging the 10 sweeps. The result will be displayed on the screen. To save the waveforms, 

click Store. 
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The test is now finished. Click on Return until to reach the Main Menu.  

12.5.4 Cleanup 

First, gently remove the corneal electrodes from the patient's eyes. Next, remove the 

indifferent/reference and ground electrodes from the patient’s forehead and ear. Use an alcohol 

pad or electrode prep pad to remove the sticky material that might have been left by the 

electrodes on the patient's skin. The patient is now completed with the test.  

 

12.6 Reports and Analysis 

 

To prepare a report for a specific patient: 

 Retrieve the patient’s waveforms (see section 10.6.5 on how to retrieve waveforms). 

 Place cursors on the waveforms or use another method to analyze them (see section 

10.6.9 on how to place cursors using EMWIN). 

 Print out the reports (see section 10.6.10). 

 

12.6.1 Retrieving the waveforms 

 

In order to retrieve the waveform, go to the main menu and select Create Reports. Fill in the 

necessary information to search for the waveforms. For more detailed information about 

searching for waveforms, see section 10.6.5 

 

12.6.2 Step 1: Rod Response Analysis 

 

Retrieve the first two waveforms, labeled "Scotopic -24 dB”. Next, click on the Place 

Cursors icon. Place two cursors on the waveform as shown in the figure below. Place 

Cursor 1 on a flat spot in front of the waveform and place Cursor 2 at the peak of the waveform 

(see section 10.7 on how to create report and place cursors). The calculated difference between 

cursors 1 and 2 gives the amplitude of the b-wave. B-wave latency is represented by the timing 

of cursor 2.  

 

After the cursors are placed properly on both waveforms, click on Store to save the cursor 

positions with each waveform. 

 



Testing the Patient 
 

Version 2.4 93 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12.6.3 Step 2: Maximal Response Analysis 

 

After storing the cursors with the waveforms, click Return to return to the 

Reports Menu. Next, retrieve the following pair of waveforms (either by 

clicking on Retrieve -> Next by clicking on the Search For Waveforms icon 

or by clicking on Next). These waveforms should say "Scot W 0 dB SF." Place 

the cursors as described below: 

Cursor 1 should be placed on a flat spot of the waveform before the amplitude decreases in the 

a-wave. Cursor 2 and 3 should be placed on top of each other at the trough of the a-wave. 

Cursor 4 should be placed at the peak of the b-wave. If there is a small bump at the top of the 

b-wave, place the cursor to one side of the bump, not directly on the top.  

The calculated difference between cursors 1 and 2 represents the amplitude of the a-wave, 

while the calculated difference between cursors 3 and 4 represents the amplitude of the b-wave. 

After the cursors are placed properly on both waveforms, click Store to save the cursor 

positions with the corresponding waveforms. 
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12.6.4 Step 3: Oscillatory Potential Analysis 

 

Retrieve the next set of waveforms that correspond to step 3. These waveforms should read 

"Scot OPs 0 dB." They will be the recorded measurements of the oscillatory potentials and will 

resemble the one shown below. 

 

With this particular waveform, the program will automatically place cursors. Click on the 

Analyze Oscillatory Potentials icon or use the menu tool bar and select Analyze -> 

Oscillatory Potentials. When the program asks, tell it to place cursors on the Ops. The results 

will be similar to the ones on the waveform below.  

 

Note that the cursors placed by the program will not be saved on the original waveforms; 

instead, a new waveform with the oscillatory potential cursors will be created in the database.  
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12.6.5 Step 4 Photopic Response Analysis 

 

Retrieve the next set of waveforms, from step 4, labeled "Phot W 0 dB SF." Place cursors (and 

store them) as dictated below. The Photopic waveform is generally faster and smaller than the 

Scotopic waveforms because only cone function is being tested.  

Cursor 1 should be placed on a flat spot of the waveform before the amplitude decreases in the 

a-wave. Cursor 2 and 3 should be placed on top of each other at the trough of the a-wave. 

Cursor 4 should be placed at the peak of the b-wave. If there is a small bump at the top of the 

b-wave, place the cursor to one side of the bump, not directly on the top.  

The calculated difference between cursors 1 and 2 represents the amplitude of the a-wave, 

while the calculated difference between cursors 3 and 4 represents the amplitude of the b-wave. 

After the cursors are placed properly on both waveforms, click Store to save the cursor 

positions with the corresponding waveforms. 
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12.6.6 Step 5: Flicker Analysis 
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Finally, call up the last set of waveforms from step 5. These waveforms will be labeled 

"Photopic 0 dB 30 Hz" And they correspond to the flicker tests. 

To analyze these waveforms, go to the menu and select Analyze ->Flicker Amplitude 

and Timing, or use the Analyze flicker icon. This analysis will not put cursors on the 

waveform like the oscillatory potential analysis. Instead, it will produce a comment display that 

will contain the amplitude and timing information as determined by the analysis program. 
 

 

 

 

 

 

 

 

 

 

THE FOLLOWING ARE STEP BY STEP QUICK GUIDES FOR ERG 

May be copied and kept with your system for reference 
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STEP-BY-STEP INSTRUCTIONS FOR PERFORMING THE STANDARD ERG 

Patient Preparation 

 Anesthetize the patient eye(s) to be tested. 

 Put dilating drops into the eye(s). 

 Completely patch the eye(s) to be tested or seat the patient in a dark room for dark adaptation. 

During dark adaptation no light may get into the eye (a red light, like the background red light 

from the Ganzfeld, can be used to see and does not affect dark adaptation). The patient must be 

dark adapted for at least 20 minutes. 

Computer Setup Before the Patient is Brought for Testing 

 Turn the system on and wait for the Main Menu to appear. 

 Turn the UBA-4204 ON  

 On the Menu, select Test -> Electroretinogram. -> Standard. 

 Enter the patient information. Do not use spaces or punctuation in the data fields, as this may 

interfere with the search and retrieval of waveforms. 

 Add channel information. The right eye is hooked up to channel 1 and should be labeled OD or 

R. The left eye gets hooked up to channel 2 should be labeled OS or L. Click continue 

Patient Hook-Up 

 Seat the patient in front of the Ganzfeld globe, clean the forehead with an electrode prep pad and 

allow the alcohol to dry. 

 Turn the red background light of the Ganzfeld on to provide light to place the electrodes. 

 Place an EKG electrode on the forehead. Connect the pinch connector to the nipple of the EKG 

electrode. Plug the pin end of the pinch connector lead into the receptor of the one-to-two splitter. 

 Place the two leads from the splitter into the 1- and 2- positions of UBA-4204. 

 Connect the two ERG Jet electrodes into the 1+ and 2+ positions of UBA-4204. 

 Before the ERG Jet electrodes are actually placed on the corneas, put another drop or two of the 

anesthetic in the eye. The anesthetic wears off after approximately fifteen minutes. 

 Fill the lens of the electrodes with Goniosol or any Methyl cellulose solution and place the 1+ 

electrode on the right cornea and the 2+ electrode on the left cornea, and tape wires to the cheeks. 

(Follow the directions on the ERG-Jet electrode box.) 

Performing the Test 

 Click on the Record icon. 

 If the Baseline appears to be good, click on Record. 

 If the waveforms are good, click Store to save them. Otherwise, wait a period of time before 

repeating the step (wait 2 seconds for step 1, 10 seconds for step 2, and 15 seconds for step 3). 

Select Step, then Forward. The display will indicate that you are on the next step. 

 Repeat these steps (from the Performing the Test section) until the waveforms from steps 1-5 

have been recorded and stored.  

 The patient is now completed with the testing. All electrodes can be removed properly. The 

affected skin should be cleaned and the corneas washed with saline solution.  

 The waveforms can now be retrieved and analyzed, and the reports printed.  

 

Afterward the appointment 

 The forehead rest should be cleaned and disinfected using a mild disinfectant such as 

glutaraldehyde (e.g. Cidex) or an isopropyl alcohol wipe. 
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13.0 The Visual Evoked Response (VER) 

 

13.1 Overview 

 

The Visually Evoked Response (VER) - also called the Visually Evoked Potential (VEP) or 

Visually Evoked Cortical Potential (VECP) – is a test used to measure the electrical response of 

the primary visual cortex when visually stimulated. The response is measured from Brodman's 

Area 17 of the cortex, an area concerned mostly with foveal vision. The most commonly used 

visual stimulus is an alternating checkerboard pattern, although a flash of light can also be used. 

In clinical testing, the electrical response of the visual cortex is measured by placing one 

electrode on the scalp directly over the visual cortex, a second on a reference location (such as the 

ear) and measuring the difference between these two responses. The sensitive amplification system 

is able to measure the difference (typically millionths of a Volt, or microvolts, µV). Note that a 

typical wall outlet produces over 100 Volts which is about ten million times greater than the 

typical VER signal. 

A normal VER is indicative of a properly working visual pathway - from the foveal retina through 

the optic nerve to the visual cortex. The VER can provide useful information for the diagnosis 

and treatment of many conditions; including, optic neuropathies, differential diagnosis of 

unexplained acuity loss (with the focal ERG), and malingering blindness. 

Typically, the VER is recorded in response to an alternating checkerboard stimulus. The electrical 

response to this pattern stimulus consists of an initial negative wavelet followed by a positive 

one (the VER may contain a few additional wavelets, but only the first two are of primary 

clinical significance). There are many factors that can influence the amplitude of the VER 

(including skull thickness and electrode location), so the timing of the waveform is the most 

useful diagnostic measure in this test. The negative wave, which generally occurs at 75 

milliseconds (ms), is called N75 while the positive wavelet, which occurs at almost exactly 100 

ms, is known as P100. Disease states that affect the VER prolong the waveform, leading to an 

increased timing in the P100 wavelet. 

The flash VER is most useful in evaluating ocular trauma. It provides evidence of some foveal 

vision, indicating that a reconstruction of the eye is likely to be successful. The flash VER is a 

complicated waveform that is quite varied between subjects. Usually, the useful information 

gathered from the flash VER waveform is whether or not it is present. 

 

13.2 Patient Preparation 

 

Because electrodes will be attached to the scalp, the patient should be advised to wash their hair 

within 24 hours of the test and not to use any hair products the day of testing. 

 

Before starting the test, make sure that the patient is properly refracted. 
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Errors in refractive correction will give inaccurate test results. The patient can simply wear their 

normal prescription eyeglasses or contacts during the test. If the patient's glasses prescription are 

not be correct, be sure to check and correct before proceeding with the test. 

The first step is to decide the locations from which to place the electrodes and record. Usually, a 

single electrode at OZ and one reference electrode will be sufficient. If the purpose of the test is to 

diagnose pre- versus post-chiasmal optic nerve defects, electrodes must be placed at both 01 and 

02.  

 

                             Typical recording sites and landmarks for the VER 

To identify the recording sites to place the electrodes on the patient’s scalp, first identify the 

inion, the bony protrusion at the back of the skull. 

If you are recording on an adult with a normal-sized head, the Oz is located 

about 2.5 cm (1 inch) above the inion on the midline. 01 and 02 are located 

2.5 cm (1 inch) to the left and right of Oz. 

If the subject has an abnormal-sized head, is an infant, –or if it is important that the electrodes are 

placed in the exact locations, making a few measurements will determine the locations for the 

recording sites. First, identify the nasion, the bony ridge along the brow line just above the nose 

on the front of the head. Measure the distance from the nasion, over the head, to the inion. Next, 

locate the two pre-auricular points, the bony protrusions of the mastoid bone just in front of the 

ear and measure the distance around the back of the scalp between the two pre-auricular points. 

 The Oz point is located on the midline, 10% of the distance from the inion to the 

nasion above the inion. 

 O1 is located at the same elevation as Oz , 10% of the distance between the pre-

auricular points to the left of midline 

 O2 is located at the same elevation as Oz , 10% of the distance between the pre-

auricular points to the right of midline 

Ty pical recording sites and lan dmarks for the V ER
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13.3 VEP Electrodes 

 

The VEP is measured using three types of electrodes: the recording (positive) 

electrodes, the reference (negative) electrode, and the common (ground) 

electrode.  The positive electrodes are gold cup electrodes, as shown on the 

right. This electrode is typically placed in the Oz location. The negative 

electrode is typically either an ECG electrode or another gold cup electrode. 

This is typically placed on the forehead, or along the Fp site. The common 

electrode is typically an ear clip. 

 

Clean the electrode site thoroughly to remove all skin oils and other debris that might inhibit the 

electrode to making a good electrical contact.   

 

Fill the cups of the ear clip electrode with electrode gel (not cream) and clip it to the patient’s ear 

lobe. Then connect this to the ground/common site on the amplifier.   

 

Locate the positive electrode site(s).  Part any hair to expose the skin at the recording site, and 

vigorously scrub the skin with an electrode prep pad.  (If the patient’s hair is long, bobby pins or 

other clips should be used to hold the hair out of the way during this process.) 

 

Note: It is important to clean the scalp thoroughly to obtain a good electrode 

contact. 
 

Using a generous dollop of electrode cream (not gel); paste the hair on each side of the part to 

the scalp or use bobby pins to securely hold down the hair. The important thing is to keep the 

scalp exposed.  Next, put a generous portion of electrode cream in the cup of the electrode and 

press the electrode firmly into place on the scalp.  Cover the electrode with a 2 to 3 cm (1 to 1½ 

inch) square of tissue paper, and press firmly again. 

 

Repeat this procedure for each electrode being used.  Plug the other end of the electrode into the 

positive (+) side of the Amplifier unit, taking note of which electrode is plugged into which 

channel if you are using more than one.   

 

The negative (reference) electrode is typically an ECG electrode that is placed on the forehead, 

attached to a wire and place in the negative side of the amplifier unit. If you have more than one 

positive electrodes, attach a splitter to the end of the negative electrode and place them in the 

corresponding negative channels on the amplifier.   

 

13.4 Recording data 

 

13.4.1 Setting Up the Test 

 

After the electrodes have been attached to the patient, the test can begin. This section of the 

manual contains information that was explained in the Software Manual. 

 From the Main Menu, click on Perform Tests -> Visual Evoked Response -> Pattern. 
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 Fill in the patient information (as much as possible, but at least the First and Last 

Names). 

 Enter the number of channels used/electrodes to be recorded from. Label the channels 

with the name of the site (OZ, O1, etc.) Select which eye is being recorded and click 

continue. 

 

The test is now ready to begin. Make sure the patient is seated comfortably and located 1 meter 

away from the screen. 

 

Note: Any muscle contraction may be picked up as noise on the recording, so it 

is important that the patient is as relaxed as possible in order to get a decent 

recording. 

 

13.4.2 Record  

 

Now click on the Record Icon. The baseline should look somewhat like a good baseline 

of other tests. There should be about 20 to 50 µV of signal visible on the screen (most of 

this is EEG activity generated by the brain). 

 

 
 

Bad VEP Baseline 
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The shown baseline is an example of a bad baseline. The patient may be tensing his neck/shoulder 

muscles so that a large amount of EMG (muscle electrical activity) is measured. If the patient’s 

baseline looks like this one, encourage the patient to relax as much as possible. 

 

If the baseline appears to have a large number of vertical lines on the screen spaced about 15 

milliseconds apart (20 milliseconds apart in Europe and Asia), then there is power line 

interference. The most likely cause of this baseline is poor electrode contact. Be sure to press 

firmly on each of the scalp electrodes and try another baseline. 

Note: Poor electrode contact is the most common reason for poor VER recordings! 

 

 

13.4.3 Recording Data 

When the baseline is acceptable, it’s time to record. Just before clicking on Record, instruct the 

patient to carefully watch the screen and to think about something else (about 20% of patients are 

able to reduce their VER amplitude by concentrating on other topics). 

The default VER protocol will average 80 responses to obtain a waveform. The number of 

responses averaged appears in the lower right portion of the screen. If, while watching the 

waveform (which displays every 10 sweeps), it does not significantly change, the test may be 

safely stopped. In most cases, as few as 30 responses will give you a satisfactory recording. 

When the recording has finished, instruct the patient to relax. Patient fatigue can affect the test 

results, so encourage them to close their eyes and relax. It is a good idea to wait a few seconds 

between the tests to allow the patient to recover. 

The first stimulus presented in the pattern VER protocol is a checkerboard composed of 32 x 32 

alternating squares. For most purposes, this stimulus will be the only one needed. If other 

responses are desired, the check sizes in the default pattern VER protocol will be: 

32 x 32, 8 x 8, 16 x 16, 64 x 64, 128 x 128 

When testing multiple responses to different check sizes, click on Step Forward Icon to 

go to the next check size. 

Remember to store the waveforms (by clicking Store). If the waveforms are not stored, 

the software will automatically prompt you if you want to save them or not. 

When the test is finished, return to the Main Menu by clicking on the Return Icon. 
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13.4.4 Cleanup 

Gently remove the electrodes from the patient's scalp. The electrode cream should be cleaned out 

of the patient's hair using warm, damp paper towels. Electrode cream is not soluble in alcohol, so 

electrode prep pads will not be able to remove it. 

 

13.5 Reports and Analysis 

To prepare the reports on a particular patient,  

 Retrieve the waveforms for that patient (see section 10.6.5 for more info). 

 Place the appropriate cursors on those waveforms (section 10.6.9 for more info). 

 Print out the reports (section 10.6.10 for more info). 

 

13.5.1 Retrieving waveforms 

 

To retrieve the waveforms, start from the main menu and select Create Reports. Fill in the 

necessary information to search for and retrieve the waveforms (for more detailed information 

see section 10.6.5). 

13.5.2 Analysis 

To analyze the waveforms retrieved, click on the Cursors icon. Place cursors on the 

waveform as shown in the figure below. Place Cursor 1 at the bottom of the major trough, 

which usually occurs at 70 milliseconds. Place Cursor 2 at the top of the peak, which usually 

occurs at 100 milliseconds. 

Note: Patients with a disease may have significantly altered peak/trough timing. 



Testing the Patient 
 

Version 2.4 105 

 

 

After the cursors are placed properly on the waveform, click on the Store icon to 

save the cursor positions with the waveform. 

 

 

13.5.3 Smoothing 

Before printing the waveform, it may be a good idea to smooth it. Smoothing the 

waveform will remove the small bumps. To smooth, click on Analyze ->Smooth or use 

the smooth icon. If you smooth the waveform and then click on the save icon it will save as a 

new waveform. See section 10.6.2 for more info on smoothing. 

 

 
 

 

 

 

THE FOLLOWING ARE STEP BY STEP QUICK GUIDES FOR VEP 

May be copied and kept with your system for reference 
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STEP-BY-STEP INSTRUCTIONS FOR PERFORMING THE VEP 

Computer Setup before Patient Preparation 

 Turn the system on. 

 Turn the UBA-4204 on. 

 Select Perform Test -> Visual Evoked Response.  

 Select the type of VER to be done (Pattern or Flash). 

 Add the patient information. If recording from only one channel, the electrode at the midline is 

labeled O z .  If recording from two channels, the left channel is labeled O1, and the right channel 

is labeled 02. 

 Select the eye to be tested (Right, Left, Both). 

Patient Preparation 

 Seat the patient 1 meter from the pattern stimulator. 

 Clean the ear lobe and the OZ location in the back of the head with alcohol prep pads, allow the 

alcohol to dry. 

 Fill both cups of the ear clip electrode with electrode gel and attach it to the ear lobe. This 

electrode should be connected to channel 1 on the UBA-4204 (with a one channel test and via the 

splitter in channels 1+ and 1-with a two-channel hook up). To minimize electrical 

noise/interference in a one channel hook up, short together the channel 2 + and 2 -. 

 Part the hair at the midline. 

 Hold the hair down on the scalp by using secure bobby pins or electrode cream on both sides of 

the part, 

 Fill the gold cup electrode with electrode cream and place it in the middle of the part, directly on 

the scalp, pressing down firmly on the electrode. 

 Use a one square inch of Kleenex tissue and place it over the electrode to insure the electrode is 

attached tightly to the scalp. 

 Connect the electrode to the 1+ location of the UBA-4204. 

Performing the Test 

The Standard Pattern VER Test contains a five step protocol. In each step the pattern size is changed. For 

systems with manual Pattern Stimulators, it is essential to change the pattern size according to the 

stimulus conditions found at the bottom of the computer screen. 

 Select Record. 

 If the baseline appears normal, click Record. During the test, the number of sweeps averaged is 

displayed at the bottom of the screen. 

 When the waveform is sufficient, select Stop and then Store. It is possible to finish the averaging 

and not record a perfectly smooth waveform. It is up to the technician to decide whether to repeat 

the test or to reposition the electrodes and then repeat the test. 

 Once a satisfactory waveform has been stored for a step, select Step and Forward. This will take 

the test to the next step. 

 Repeat the last four steps until step 5 has been successfully recorded and stored. 

 At this point, if a Normal Intensity Flash VER or Bright Flash VER is not needed, the patient 

can be disconnected, cleaned or electrode gel and released. 

 The waveforms can then be retrieved, cursors placed and analyzed, and reports printed. 
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14.0 The Electro-oculogram (EOG) 

 

14.1 Overview 

 

The electro-oculogram (EOG) measures changes in the standing potential of the eye in dark and 

light conditions. The standing potential of the eye is generated across the retinal pigment 

epithelial (RPE) layer, thus the EOG primarily measures RPE function. 

The EOG is a somewhat more difficult test than the ERG or VER, taking more than 30 minutes to 

complete. Consequently, it is less common than other visual electrodiagnostic tests. Nevertheless, 

there are some conditions where the EOG is quite useful; it is necessary in the diagnosis of Best's 

disease. 

The standing potential of the eye causes it to act like a weak battery. The anterior (corneal) pole of 

the eye is more positive than the posterior pole. It is not possible to measure the standing 

potential of the eye directly, as this would involve inserting an electrode behind the globe, so the 

EOG is measures the potential indirectly. 

To perform the EOG, two electrodes are placed on the skin next to the eye - one is placed near the 

temporal canthus and the other is placed near the nasal canthus. The patient then looks left and 

right. As the eye swings toward the nasal electrode, it becomes more positive than the temporal one. 

As the eye swings toward the temporal electrode, it becomes more positive than the nasal one. The 

difference between the temporal and nasal values is related to the potential across the eye. 

Because the potential measured by this technique is related to many factors including the 

placement of the electrodes and the geometry of the eye, the value is of little use by itself. The 

clinically useful value is the ratio of the peak value in the light to the minimum value in the dark. 

This is called the Arden Ratio: 

 

 

 

14.2 Patient Preparation 

 

According to ISCEV standards, the patient should be maximally dilated using a medium-acting 

mydriatic, such as Tropicamide. The patient should not be dark adapted before the test. 

Note: The patient should not be exposed to bright lights, such as a slit lamp 

or ophthalmoscope, for at least 20 minutes before the test. 
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14.3 Electrodes 

 

The EOG uses four EOG recording electrodes (two for each eye).  

Using an electrode prep pad, carefully clean the skin near the nasal and 

temporal canthi as well as one ear lobe. Take care to remove all skin oils, 

but don't get alcohol in the patient's eye. The EOG electrodes are attached to 

the patient using electrode washers, thin disks with adhesive on both sides. Remove the protective 

covering from one side of the electrode washer and affix it carefully to the EOG electrode. Align 

the washer so that its tab is near the electrode wire. Next, fill the cup of the EOG electrode with 

electrode gel (not cream). The gel should protrude slightly from the surface of the electrode 

washer. Remove the protective covering from the second side of the electrode washer and affix 

the electrode as close to the canthus of the eye as possible. A gold cup ear clip electrode is used 

for ground electrode and should be plugged into the ground connection of the amplifier.  

Attach the EOG electrodes as following: 

1-
1+ 2- 2+

 

 

14.4 Obtaining Data 

After you have attached the electrodes, the test may begin. This section requires an 

understanding of the system software. For more information on the software, read the UTAS 

Software Section first. 

14.4.1 Setting up the Test 

 From the Main Menu, click on Tests -> Electro-oculogram. 

 Fill in the patient information (at least the First and Last Names). 

 Enter the number of channels (electrodes) to be recorded. Usually with both eyes, 

channel 1 is labeled R and channel 2 is labeled L. 

 

Seat the patient in front of the Ganzfeld. Make sure that the patient is comfortable, as they will be 

sitting there for more than half an hour without a break. Instruct the patient to look at the red light 
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in the center of the Ganzfeld bowl. Tell the patient that when the lights begin to move, they should 

follow the lights with their eyes without moving their head. 

 

14.4.2 Baseline 

The software automatically starts in baseline mode. The LEDs will move from right to left 

immediately and the patient should follow these lights. See below for examples of a good and 

bad EOG baseline. To check for good electrode contact, perform an impedance check (which 

should be less than 40KΩ). If the wave is too large, interrupt the baseline, adjust the scale 

display to a lower setting, and run the baseline again.  

 
 

 
      Good EOG Baseline 
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    Bad EOG Baseline 

14.4.3 Recording Data 

Once a good baseline has been established, the recording can begin. Click on Interrupt to stop 

the baseline and then click on Record to start the test. 

The EOG collects data for the first 15 seconds of every minute. During these 15 seconds, the 

patient must consistently follow the alternating EOG fixation lights. 

Note: An important part of the technician’s job during the test is to help 

the patient remain alert (and stay awake) and to inform them of their 

progress. 

The clock at the top right of the screen will measure the time of the test. At 55 seconds into each 

minute, warn the patient that the lights will begin flashing in five seconds. When each minute 

starts, the EOG lights will begin flashing. The patient's eye movements can be monitored on the 

screen. If they are not moving their eyes with the lights, encourage the patient to follow the lights. 

At 15 seconds into each minute, the EOG lights will stop flashing and the center fixation light will 

turn on. Let the patient know that they can relax while still looking at the fixation light. 
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The EOG test consists of three phases: 

 A pre-adapt phase (light on), lasting 6 minutes. 

 A dark adapt phase (light off), lasting 16 minutes. 

 A light adapt phase (light on), lasting 14 minutes. 

Under normal circumstances, these times will not need to be changed. 

Note: Make sure the patient does not close his or her eyes during the pre-adapt 

or light adapt portions of the test. 

When the test is finished, the software will automatically display the result. Be sure to store the 

data. After, the electrodes can be removed from the patient and they can be released. 

 

14.4.4 Saving EOG raw data 

After each 15 seconds segment of alternating LED, the Save button will be available. Clicking 

this icon will save the raw EOG data for that segment into C:\EMWIN\EOG. To save all of the 

raw data, click on Save after each 15 second segment is recorded.  

 

14.5 Report and Analysis 

To prepare the patient reports: 

 Retrieve the specific waveforms (see section 10.6.5). 

 Place cursors on the waveforms (see section 10.6.9). 

 Print out the reports (see section 10.6.10). 

From the Main Menu, click on the Create Reports. Fill in the necessary patient information and 

retrieve the waveforms (they will be labeled "Electro-oculogram"). 

To place the cursors automatically to calculate the Arden Ratio, click Analyze -> Computer 

Arden Ratio. The program will place cursors on the lowest point in the dark trough and the 

highest point in the light peak. Occasionally, the cursor will not be placed in the best locations. 

ISCEV guidelines state that cursors should be placed based on an appropriate imagined smooth 

curve through the data. 

For example, if the patient fell asleep during the dark adapt portion of the test, there may be a few 

minutes where the computed value was close to zero. The program may select one of those values 

and give you an artificially high Arden ratio (in which case, cursors should be manually 

changed). 

To change a cursor value, click on the Cursors icon. Move the cursor to the correct 

location. An example of an EOG with proper cursors is shown on the next page. 
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THE FOLLOWING ARE STEP BY STEP QUICK GUIDES FOR EOG 

May be copied and kept with your system for reference 
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STEP-BY-STEP INSTRUCTIONS FOR PERFORMING THE EOG 

Computer Set up Before the Patient Arrives 

 Turn the system on. 

 Turn the UBA-4204 on. 

 Select Test -> Electro-oculogram. 

 Add the patient information line by line. Add comments as needed, up to three lines. 

 The EOG test is always a two channel test and the channels are labeled automatically. The patient 

can now be prepped for the test. 

Patient Hook-Up 

 Clean the forehead, ear lobe, and the temporal and the nasal canthi of both eyes with 

alcohol pads. Pat the areas dry. Take care to avoid getting alcohol in the patient's eyes. 

 Stick the electrode washers to the flat inner side of four EOG electrodes, leaving the paper cover on 

the exposed side. Position each "washer" so that its tab aligns with the electrode wire. 

 Fill the electrodes with gel. 

 Remove the washer tape covers and place the electrodes on the patient. 

 Each eye should have one + electrode and one – electrode (one of each color). 

 Connect the electrodes to the corresponding channels of the UBA-4204. 

Performing the Test 

 The software will automatically start in Baseline mode. Check the eye movements (the size of the 

peaks) to see if they seem uniform and of good amplitude, if so, then click Interrupt. 

 Select Record to start the test. 

 The patient's eye movements should be constantly monitored to ensure the patient remains alert 

and does not close their eyes during any phase of the test. 

 The machine will automatically place cursors on the waveforms and display the Arden Ratio at 

the end of the test. 

 If there are anomalous high points in the light adapting phase or anomalous low points in the dark 

adapt phase, the Arden Ratio will not be correct. The cursor positions will need to be changed by 

selecting Cursors from the menu. 
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Appendix 1: LKC Electrode List 

LKC Part Number   Description 

95-001        Electrode Adaptor, 1 Male/2Female 

95-002      Chin Rest Paper 

95-003      DTL Electrode     

95-004      Ear Clip Safe Lead Electrode, 48” 

95-005      ECG Electrode 

95-006      Electrode Cream     

95-007      Electrode Gel      

95-008      Electrode Jumper, Female/Female 

95-009      Electrode Washer     

95-010      EOG Electrode     

95-011      ERG-JET      

95-012      Electrode Adaptor, Female/Female   

95-013      Gold-Foil Electrode     

95-014      Ground Electrode     

95-015      Electrode Adaptor, Male/Male   

95-016      Reference Needle Electrode    

95-017      Skin Prep Pad    

95-018      VEP Safe Lead Electrode, 24”   

95-019      VEP Safe Lead Electrode, 48”   

95-020      Burian Allen – Bipolar, Adult    

95-021      Burian Allen – Bipolar, Pediatric   

95-022      Burian Allen – Bipolar, Infant   

95-023      Burian Allen – Bipolar, Small Infant   

95-024      Burian Allen – Bipolar, Special Small Infant  

95-025      Burian Allen – Bipolar, Large Premature Infant 

95-026      Burian Allen – Bipolar, Premature Infant 

95-027      Burian Allen – Bipolar, Mice 

95-028      DTL Extended Cable  

95-029      Bipolar Electrode – Rat 300-350 grams 

95-030      Electrode ECG Softrace Neonatal Snap 

95-031      Rat Electrode Monopolar 

95-032      Rabbit Electrode Monopolar 

95-033      Mouse Electrode Monopolar 
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Appendix 2: Artifacts in Electrophysiological Testing 

The first part of this appendix describes the most significant artifacts encountered in Visual 

Electrodiagnostic Testing. The second part describes various methods of limiting or minimizing 

artifacts, and the third part explains how certain features of the equipment may be used to yield the 

best possible recordings, artifacts notwithstanding. 

Artifacts in electrophysiological testing include any electrical signal generated either by either the 

subject, the recording equipment, or by the environment, which does not represent the subject's 

response to the stimulus. Artifacts can distort or obscure the evoked response to a degree that 

renders the recording of little or no diagnostic use. 

Artifacts Generated by the Subject 

Muscle Artifacts. Contracted muscles can generate very significant electrical activity. For example, 

the heart muscle generates up to 4 millivolts when measured by electrodes placed on the chest. In 

comparison, the ERG signal measures about 150 to 400 µV in amplitude, which is about 10 times 

less than those generated by the heart.. Therefore, it’s not surprising that significant distortion of 

the ERG and EOG can be produced by subjects who: 

 Tense their jaw muscles 

 Tense their eyelid muscles 

 Blink 

Muscle artifacts that interfere with the ERG and EOG produce high frequency random "noise" 

that appears on the baseline. The amplitude of this interference may be as high as ±50 µV, which 

can obscure the needed measurements. Jaw muscle noise can be particularly devastating to EOG 

recordings. 

Eye Movement Artifacts. Eye movements can produce serious errors in the ERG as well as in 

the EOG when not representing controlled response movements. 

There are two types of eye movement artifacts that affect the ERG; one is the subject's inability 

to fixate while the second is due to a reflex contraction of the orbicularis muscle in response to the 

strobe flash. This latter artifact is called the photomyoclonic reflex (PMR), and can potentially 

interfere with B wave interpretation.2 

Eye movement artifacts resulting from improper fixation produce baseline shifts. The baseline 

may be shifted entirely off the screen or appear to slant up or down across the screen. The eye 

movement can therefore cause the recording to be off. Ideally, the baseline should appear as a 

                                                 

2 For a further discussion of the photomyoclonic reflex, see 

Johnson, MA and Massof, RW. The photomyoclonic reflex: an artefact in the clinical electroretinogram. Brit. J. 

Ophthalmol. 66, 368-372 (1981). 
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horizontal line with minimal noise riding on it. If the baseline is drifting wildly, instruct the 

patient to carefully fixate on the red light in the Ganzfeld bowl. 

EEG Artifacts. For VER recordings, the principal artifact is the EEG signal. The baseline 

response is primarily EEG "noise", whose amplitude is about 50 µV (compared to the VER 

amplitude of about 10 V). In a single sweep recording, EEG noise completely obscures the VER. 

Artifacts Generated by the Recording Equipment 

Baseline or Amplifier Noise. All electrical circuits generate electrical noise due to molecular 

activity and other non-ideal aspects of signal amplification. Equipment baseline noise level can be 

observed by short circuiting the patient input terminals. This noise level is usually a few 

microvolts and is random in nature. Its amplitude depends upon the characteristics of the 

amplifier and on the recording bandwidth (filter settings). The amplitude of this baseline noise is 

small and therefore does not ordinarily interfere with the evoked potential recordings. If the 

baseline noise is greater than a few microvolts with shorted inputs, the equipment may be 

malfunctioning. On the other hand, absence of typical baseline noise is generally indicative of a 

"dead" or saturated amplifier. If there is a complete absence of equipment baseline noise, or 

excessive baseline noise, please contact the LKC Service Department. 

Electrode Noise. Electrical contact between the subject and recording electrodes is never perfect. 

The quality of the contact is termed the electrode impedance - the lower this quantity, the better, 

however it will create some electrical noise. The higher the electrode impedance, the more noise 

is generated. The patient amplifier’s susceptibility to electrical noise generated by the external 

environment increases with increasing electrode impedance. In general, the greater the electrode 

impedance is, the greater the noise in the recording. Electrode impedance, as measured by the 

system, should be less than 25 KΩ for low noise recordings. However, if the baseline noise level 

is not excessive, it is acceptable for the electrode impedance to be higher. 

Artifacts Generated by the External Environment 

60 Hertz Noise. The principal external interfering signal is electrical noise generated by power 

lines or electrical equipment connected to power lines. The typical electrical outlet provides  110 

Volt electricity, which is more than a million times greater than the amplitude of the ERG! 

Examples of equipment that can generate electrical interference are fluorescent lights, motors 

(including motorized chairs), and power transformers. These items produce powerful 

electromagnetic fields that can induce or couple 60 Hertz interference into the recordings. The 

closer the patient and the test equipment are to these sources, the more interference will be 

induced. LKC's balanced patient amplifiers will cancel most of this interference; however, 60 Hz 

interference may be seen if: 

 the patient leads or amplifiers are close to power lines or electrical equipment and/or, 

 the electrode impedance is high 
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Therefore, care should be taken to locate the testing equipment and subject away from any major 

source of electrical interference and to make sure electrode impedances are as low as possible. 

High Frequency Electrical Noise. Besides the power lines or equipment such as motors and 

transformers, electrical noise can also be produced by equipment generating noise at radio 

frequencies. Although one might expect such signals to be filtered out by the amplifier filters, it is 

possible for the equipment to generate low frequency artifacts by nonlinearities in the recording 

equipment and by mixing with other signals. Care should be exercised to keep the recording 

equipment and subject away from strong sources of radio frequency signals. 

Principal Artifacts and How to Limit or Minimize Them 

Understanding the sources of artifacts permits appropriate action to be taken to minimize the 

magnitude of this interference at the source. 

Artifacts Generated by the Subject. Muscle artifacts and eye movement artifacts that are due to 

improper fixation can be minimized by encouraging the subject to relax and to fixate on the 

Ganzfeld central fixation light. Press the baseline button to observe the baseline as the subject 

becomes calm. When it remains essentially horizontal and the random noise level appears 

"normal," testing may commence. 

The photomyoclonic reflex (PMR) is ubiquitous, occurring, to some degree, in most ERGs. If it 

occurs early in the ERG, the PMR can obscure the entire waveform. If the PMR occurs 

somewhat later, on the rising portion of the b-wave, it can prevent ERG amplitude estimation. 

Sometimes, the PMR can mimic an ERG or can add apparent amplitude to ERG responses. Subtle 

PMRs can be recognized in ERG waveforms in several ways: 1) Changes in ERG waveform slope 

that are not consistent with the expected slope; 2) ERGs of unusual amplitude or shape; and 3) 

ERGs that do not replicate. Sometimes, the eye movement is preceded by stimulation of the 

orbicularis muscle, and the resultant spiking can be observed in the waveform. 

If the PMR is present, it can frequently be habituated by presenting repetitive, predictable flashes 

of light to the subject. Stimulating approximately once per second will properly habituate the 

subject's response without causing too much light adaptation. 

Artifacts Generated by the Environment. As mentioned above, the first step in minimizing this 

interference is to be sure that there is good electrode contact: 

 

  Be sure to thoroughly clean the site of the electrode placement with skin cleaner. 

 All electrode cups should be filled with an adequate amount of electrode gel or cream. If 

an ECG electrode is used for the reference (-) electrode, make sure that the gel is still wet. 

 Good reference connections must be made. 
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 In ERG recordings, adding an extra drop of artificial tears to the contact lens electrode 

while it is in the patient's eye may reduce some electrode impedance. 

 Any unused recording channels should be shorted by placing a jumper cable between the 

+ and - inputs.  

 Electrode leads should be as short as possible and kept away from any electrical 

equipment, power lines, or electromagnetic fields (it helps to twist the positive and 

negative electrode leads in order to cancel their magnetic induction; about one twist per 

inch is adequate). 

 

With these precautions, electrical noise due to primary power source equipment and radio 

frequency equipment will ordinarily be within acceptable limits. 

 

How to Deal with Artifacts Using System Features 

Muscle Artifacts. If, after applying the above suggestions, the muscle artifacts are still 

excessive, they may be reduced by averaging. For the ERG, averaging 10 sweeps should reduce 

the noise level to an acceptable level. To minimize light adapting the subject from repeated 

flashes, sett the time between sweeps to 15 seconds. Although averaging is the preferred solution 

in most cases, muscle artifacts may also be partially filtered by the amplifier filters. Since muscle-

generated noise is generally at the high end of the spectrum, it can be reduced in the ERG by 

setting the low-pass (high cut) filter to 100 Hz, rather than the usual default of 500 Hz. A 70 Hz 

filter may be attempted, but significant distortion of the recording will result and proper latency 

measurements will not be possible. In the standard EOG protocol, the filter values are preset and 

cannot be changed. 

Another way to deal with muscle noise is to smooth the waveform. Smoothing the waveform 

produces a filtered effect, which will not alter the latency of the waveform.  

Eye Movement Artifacts. If a steady baseline cannot be obtained the baseline may be stabilized 

by averaging. With averaging, the effects of positive and negative eye movements are partially 

canceled. Averaging 10 sweeps will generally allow a satisfactory recording to be obtained. If 

patient light adaptation is a concern with the repeated flashes, set the time between sweeps to 15 

seconds. When employing signal averaging with automated artifact rejection, the artifact reject 

level should be set to eliminate those waveforms that are obviously not representative of the true 

response. The artifact reject criterion should be selected to be about 20% greater than the largest 

"true" signal expected. If too many waveforms are rejected, increase the criterion. 

Although averaging is the preferred solution in most cases, eye movements can be removed by 

analog filtering. Since eye movement noise affects the low end of the waveform frequency 

spectrum, it can be reduced by setting the high-pass (low cut) filter to 1 Hz (rather than the default 

of DC). The 5 Hz filter may be attempted for difficult cases, but there will be significant 

distortion on the recording. 

Another option for dealing with a drifting baseline is to use the Baseline Correct feature; see 

section 10.6 for more information.  
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EEG Artifacts. The primary mechanism for reducing EEG artifacts in the VER is to use signal 

averaging. Theoretically, EEG noise and other noise uncorrelated with the stimulus will be 

reduced by the square root of the number of sweeps averaged. For example, if 50 sweeps were 

averaged, the noise would be reduced by approximately 7. This is usually adequate to obtain 

satisfactory VER recordings. The use of low pass (high cut) filtering can also be helpful. Whereas 

the VER default filter setting is at 100 Hz, the 30 Hz filter will produce a smoother waveform. 

Note: the use of the 30 Hz filter will add 5 to 10 ms to the latency estimate. 

Artifacts Generated by the Equipment. Other than taking the listed precautions,, there may not be 

much that can be done to reduce the effects of high frequency noise artifacts. It may, in fact, be 

difficult to recognize this form of interference since it is translated to lie within the bandwidth of 

the recording. As a rule, if the interference is periodic, and not 60 Hertz, then high frequency 

noise should be suspected. Depending on the frequency of the interference and where it 

originates, it may be possible to reduce it by with either the high pass or low pass filters. 
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Appendix 3: LKC Normal Data 

 
Normative Data for the Clinical Electroretinogram 

 

Means and Standard Deviations as a Function of Age for the Most Commonly Measured Parameters 

of the International Standard (ISCEV) ERG Protocol 

 

Monopolar Electrodes (e.g. ERG-Jet) 

 

Stimulus Parameter Change With Age S.D. 

24 dB Scotopic Flash b-wave amplitude 330 µV - 2.2 µV/year 61 µV 

 

0 dB Scotopic Flash 
b-wave amplitude 644 µV - 1.6 µV/year 117 µV 

 b-wave implicit time 47.5 ms 3 ms 

Oscillatory Potentials summed amplitude 235 µV - 2.1 µV/year 50 µV 

 

0 dB Photopic Flash 
b-wave amplitude 183 µV - 1.0 µV/year 37 µV 

 b-wave implicit time 29.5 ms 1.5 ms 

 

30 Hz Photopic Flicker 
Amplitude 133 µV - 0.7 µV/year 30 µV 

 implicit time 26.8 ms + 0.02 ms/year 1.8 ms 

 

 
Bipolar Electrodes3 (e.g. Burian-Allen) 
 

Stimulus Parameter Change With Age S.D. 

24 dB Scotopic Flash b-wave amplitude 260 µV - 1.7 µV/year 48 µV 

 

0 dB Scotopic Flash b-wave amplitude 507 µV - 1.3 µV/year 92 µV 

 b-wave implicit time 47.5 ms 3 ms 

Oscillatory Potentials summed amplitude 185 µV - 1.7 µV/year 39 µV 

 

0 dB Photopic Flash b-wave amplitude 144 µV - 0.8 µV/year 29 µV 

 b-wave implicit time 29.5 ms 1.5 ms 

 

30 Hz Photopic Flicker Amplitude 105 µV - 0.6 µV/year 24 µV 

 implicit time 26.8 ms + 0.02 ms/year 1.8 ms 

 

                                                 
3 ERG amplitudes for bipolar electrodes, such as the Burian-Allen bipolar electrode are 0.79 

(±0.03) times those of a monopolar electrode, such as the ERG-Jet 
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How To Use the ERG Normative Data 
 

ERG amplitudes decrease with age, while some implicit times increase with age.  Consequently, 

some of the normative data provided are expressed as a value plus or minus a change per year of 

age.  ERG amplitudes also depend on the type of electrode (monopolar or bipolar) that is used.  

Make sure to use values from the table that is appropriate for the electrodes used.  For example, 

to calculate the mean value of b-wave amplitude for the 0 dB scotopic flash response of a 67 

year old patient using an ERG-Jet electrode: 

 

 

 

ERG amplitudes and implicit times will vary among individuals and all are approximately 

normally distributed.  Accordingly, 95% of all normal values will fall below 1.65 standard 

deviations from the mean.  For the 67 year old patient above, the 0 dB scotopic flash response 

would have a 5% chance of being normal if it were below 537 - (1.65 x 117) or 344 µV.  To 

determine cutoff probabilities other than 5%, use the table below to select the appropriate 

multiplier. 

 

 

Probability Multiplier 

2.5 %      1.96       

5 %      1.65       

10 %      1.28       

 

 

Notes: 

 

 These normative data are valid for subjects between the ages of 20 and 80.  Extrapolations to 

younger or older ages should be made with care.  

 

 Oscillatory Potential amplitudes were determined using the Analyze Oscillatory Potentials 

function of LKC's software package.  They were not determined using the analog filtered 

waveform.   

 

 The 30 Hz flicker amplitude and implicit time were determined using the Flicker Amplitude 

and Timing function of LKC's software package.  They were not determined by placing 

cursors on the waveform. 

 

The data reported here were collected under a grant to LKC from the National Eye Institute.  

ERG data was collected from one eye of 122 subjects with ophthalmoscopically normal fundi 

and no history of diabetes.  Their ages ranged from 22 to 79, with approximately equal 

representation in each decade.  Cursors were placed on waveforms by experienced technicians.  

Linear regression was used to determine the age-dependence of each parameter.   









 years

year

V
VMean  67

 1.6
 -  644



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Normative data for other ERG parameters of interest was measured with a monopolar 

electrode.   
 

To determine the normal value for any age, add the constant value to the product of the patient's 

age and the change per year (if any).  For bipolar electrodes, divide amplitude values by 1.26.  

The 95% limits of normal are the mean ± 2 S.D. 

 

Stimulus and Parameter 
Normal Value 

(Linear Regression) 
S.D. 

Distribution 

Shape 

0 dB Scotopic Flash  a-wave amplitude 387 µV - 2.1 µV/year 70 µV Normal 

0 dB Scotopic Flash  a-wave implicit time 21.2 ms + 0.03 ms/year 1.0 ms Unknown 

30 Hz Scotopic Flicker amplitude 126 µv - 0.3 µv/year 30 µV Normal 

30 Hz Scotopic Flicker implicit time 27.5 ms +0.06 ms/year 2.2 ms Unknown 

Naka-Rushton   log K -2.68 + 0.006/year 0.20 Lognormal
*
 

Naka-Rushton   Rmax 558 µV - 0.83 µV/year 113 µV Normal 

 

  * Data are lognormal after addition of a constant. 
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Limits of Normal for the Clinical Electroretinogram 

 
95% Limits of normal as a function of age for the most commonly measured parameters of the 

 International Standard (ISCEV) protocol using monopolar electrodes 

 

24 dB Scotopic Flash b-wave Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 185 163 141 119 97 75 

 

0 dB Scotopic Flash b-wave Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 419 403 387 371 355 339 

 

0 dB Scotopic Flash b-wave Implicit Time should be below: 
Age 20 30 40 50 60 70 

Time (ms) 52 52 52 52 52 52 

 

Oscillatory Potential Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 110 89 75 61 50 50 

 

0 dB Photopic Flash b-wave Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 102 92 82 72 62 52 

 

0 dB Photopic Flash b-wave Implicit Time should be below: 
Age 20 30 40 50 60 70 

Time (ms) 32 32  32 32 32 32 

 

30 Hz Photopic Flicker Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 70 63 56 49 42 35 

 

30 Hz Photopic Flicker Implicit Time should be below: 
Age 20 30 40 50 60 70 

Time (ms) 30 30 30.5 30.5 31 31 
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Limits of Normal for the Clinical Electroretinogram 

 
95% Limits of normal as a function of age for the most commonly measured parameters of the 

 International Standard (ISCEV) protocol using bipolar electrodes 

 

24 dB Scotopic Flash b-wave Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 146 129 111 94 77 59 

 

0 dB Scotopic Flash b-wave Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 331 318 306 293 280 268 

 

0 dB Scotopic Flash b-wave Implicit Time should be below: 
Age 20 30 40 50 60 70 

Time (ms) 52 52 52 52 52 52 

 

Oscillatory Potential Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 87 70 59 48 40 40 

 

0 dB Photopic Flash b-wave Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 81 73 65 57 49 41 

 

0 dB Photopic Flash b-wave Implicit Time should be below: 
Age 20 30 40 50 60 70 

Time (ms) 32 32  32 32 32 32 

 

30 Hz Photopic Flicker Amplitude should be above: 
Age 20 30 40 50 60 70 

Amplitude (µV) 56 50 44 39 33 28 

 

30 Hz Photopic Flicker Implicit Time should be below: 
Age 20 30 40 50 60 70 

Time (ms) 30 30 30.5 30.5 31 31 
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Normative data for ERG b/a amplitude ratio 
 

 

Methods: Data was collected from the right eye of 110 normal subjects aged 22 to 79.  

There was approximately the same number of subjects in each decade.  ERG responses were 

measured from the “maximal response” step (0 dB scotopic flash) of the ISCEV standard ERG 

protocol.  Cursors were placed on the waveform by experienced technicians.  A-wave amplitude 

was measured from a quiet spot on the baseline to the trough of the a-wave.  B-wave amplitude 

was measured from the trough of the a-wave to the peak of the b-wave.   

 

B-wave/A-wave amplitude ratios were computed and the change with age was determined by 

linear regression.   

 

Results: B-wave/A-wave amplitude ratio changed significantly with the age of the patient (p = 

0.0011, t-test); however there is a large standard deviation which results in a low correlation 

coefficient (R
2
 = 0.09).  Linear regression of B-wave/A-wave amplitude ratio results in the 

following relationship: 

 

 

 

 

 )(0095.64.1     yearsAge
a

b
Mean 
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Limits of Normal for Visually Evoked Potentials 
 

 

95% Limits of Normal for P100 Latency of the 

Pattern Visually Evoked Potential 

 

Checks on Screen 
Check Size 

(minutes of arc) 

Upper Limit of Normal 

(ms) 

4 x 4 199'             119 

8 x 8 100'             110 

16 x 16 50'             109 

32 x 32 25'             118 

64 x 64 12'             123 

128 x 128 6'             141 

 

Check sizes are given for the recommended viewing distance of 1.0 meter  

 

 

Limits of Normal for Features of the  

Flash Visually Evoked Potential 
 

Feature Lower Limit Upper Limit 

         N40 36             60             

         P71 50             90             

         N91 70             120             

         P114 95             155             

         N154 115             200             

 

 

Note: Amplitudes of the pattern and flash Visually Evoked Potential are highly variable and are 

seldom of clinical interest.   
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Appendix 4: Recommended Literature and Website 

 
Website: 

 

ISCEV (International Society for Clinical Electrophysiology of Vision) 

Website: www.iscev.org 

 

Books: 

Fishman, GA, Birch, DG, Holder, GE and Brigell, MG (2001) Ophthalmology Monograph 02: 

Electrophysiologic testing in disorders of the retina, optic nerve, and visual pathway. American 

Academy of Ophthalmology, 2nd Edition 2001. 

Principles and Practice of Clinical Electrophysiology of Vision, Second Edition 

Edited by John R. Heckenlively and Geoffrey B. Arden 

Steven Nusinowitz, Graham E. Holder and Michael Bach, Associate Editors 

 

 

 

http://www.iscev.org/
http://mitpress.mit.edu/catalog/author/default.asp?aid=31037
http://mitpress.mit.edu/catalog/author/default.asp?aid=31038
http://mitpress.mit.edu/catalog/author/default.asp?aid=31039
http://mitpress.mit.edu/catalog/author/default.asp?aid=31040
http://mitpress.mit.edu/catalog/author/default.asp?aid=31041
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Appendix 5: Standard Protocols 

 

The following pages contain the software settings for each of the LKC standard protocols that 

come with the UTAS system. Some of the protocols are repeated for different stimulators (e.g. 

the Standard ERG protocol appears for the Grass Flash and Kurbisfeld stimulators). 

The protocols are organized by test: ERG protocols, VER protocols, and EOG protocols. 
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2008 STANDARD ERG PROTOCOL  
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STANDARD ERG PROTOCOL WITH WHITE ONLY MINI GANZFELD 
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STANDARD ERG PROTOCOL WITH COLOR MINI GANZFELD 
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ERG EXTENDED PROTOCOL 
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CLASSIC ERG PROTOCOL  
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FLICKER ERG PROTOCOL 
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FLICKER ERG WITH WHITE MINI GANZFELD 
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